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Πρόλογος 

Ο λόγος που επέλεξα να εκπονήσω την συγκεκριμένη πτυχιακή εργασία ήταν το όφελος που θα είχε 

στους φοιτητές του τμήματος η παρακολούθηση των εκπαιδευτικών βίντεο για την επεξεργασία βίντεο. 

Σε συνδυασμό με τα μαθήματα που προσφέρει το τμήμα που αφορούν τα οπτικοακουστικά μέσα ο 

φοιτητής θα μπορέσει να εκβαθύνει τις γνώσεις του μέσα από ένα επαγγελματικό πρόγραμμα 

επεξεργασίας των οπτικοακουστικών μέσων. Τα κεφάλαια στην πτυχιακή εργασία είναι βοηθητικό-

συμπληρωματικό υλικό που συμβαδίζουν παράλληλα με τα μαγνητοσκοπημένα βίντεο. Τα 

μαγνητοσκοπημένα βίντεο τα δημιούργησα με την χρήση του προσωπικού μου υπολογιστή και με την 

βοήθεια του προγράμματος «OBS Studio», το οποίο είναι ένα δωρεάν πρόγραμμα καταγραφής εικόνας 

και ήχου, την επεξεργασία των καταγραφών για την τελική εξαγωγή των βίντεο την έκανα με την χρήση 

του προγράμματος «Premiere Pro CC» το οποίο είναι και το πρόγραμμα που βασίζεται η πτυχιακή 

εργασία. 
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Περίληψη 

Σκοπός της πτυχιακής εργασίας είναι η δημιουργία εκπαιδευτικών βίντεο που στοχεύουν στην 

εξοικείωση με τη διεργασία επεξεργασίας βίντεο σε ψηφιακό μη γραμμικό περιβάλλον συναρμογής 

(montage) υπολογιστή. Τα βίντεο αρχικά θα βοηθούν έναν μη έμπειρο χρήστη να κατανοήσει τις 

διαδικασίες και τα εργαλεία που χρησιμοποιούνται στη μη γραμμική επεξεργασία βίντεο και κατόπιν 

θα παρουσιάζουν βήμα - βήμα παραδείγματα με χρήση των βασικότερων εξ' αυτών για την επεξεργασία 

συγκεκριμένων πλάνων. Το προσδοκώμενο αποτέλεσμα κατόπιν παρακολούθησης της σειράς των 

βίντεο, θα εστιάζει στη γνωριμία με το αντικείμενο και στην απόκτηση προσωπικής ικανότητας 

παραγωγής ολοκληρωμένων οπτικοακουστικών προϊόντων. Το υλικό των βιντεοδιαλέξεων θα 

χαρακτηρίζεται από σαφή δομή και έντυπη τεκμηρίωση ούτως ώστε να μπορεί να χρησιμοποιηθεί ως 

αυτοτελές υλικό υποστήριξης εκπαίδευσης αρχαρίων αλλά και πιο έμπειρων χρηστών. Η παρουσίαση 

των πραγματικών εργαλείων και εφαρμογών, θα βασιστεί σε χρήση της σουίτας Adobe Premiere Pro 

CC. 
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«Video Tutorial Series for Using Nonlinear Video Editing Techniques 

and Tools» 

 

«Anastasios Tastsidis» 

 

Abstract 

The purpose of the dissertation is to create educational videos that aim to familiarize yourself with the 

video editing process in a digital non-linear computer montage environment. The videos will initially 

help an inexperienced user to understand the procedures and tools used in non-linear video editing and 

then provide step-by-step examples using the most basic of them to edit specific shots. The expected 

result after watching the series of videos, will focus on the acquaintance with the subject and the 

acquisition of personal ability to produce complete audiovisual products. The material of the video 

lectures will be characterized by a clear structure and printed documentation so that it can be used as a 

stand-alone material to support the training of beginners and more experienced users. The presentation 

of the real tools and applications will be based on the use of the Adobe Premiere Pro CC suite. 
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Κεφάλαιο 1ο: Τρόπος και Λόγος Δημιουργίας της Πτυχιακής 

Η παρούσα πτυχιακή εργασία δημιουργήθηκε με το εξής σκεπτικό. Ο κύριος σκοπός είναι να γίνει 

κατανοητό  σε κάθε ενδιαφερόμενο ο τρόπος που μπορεί να γίνει η γραμμική επεξεργασία βίντεο. 

Βασικός στόχος ήταν εξ΄ αρχής να συμπεριληφθούν και γίνει αναλυτική επεξήγηση των βασικών 

γνώσεων και εργαλείων που δύναται να χρησιμοποιηθούν για τον προαναφερόμενο στόχο. Με την 

παραπάνω λογική επιλέχτηκε η ύλη που απαρτίζει την εν λόγω πτυχιακή εργασία.  

Για να δημιουργηθούν όλες οι προϋποθέσεις που να κάνουν άμεση και κατανοητή τη γνώση της 

γραμμικής επεξεργασίας βίντεο, ήταν αναγκαίο να δημιουργηθούν εκπαιδευτικά βίντεο που να εξηγούν 

βήμα-βήμα την όλη διαδικασία με τρόπο άμεσο και απόλυτα συγκεκριμένο. Τα εν λόγω εκπαιδευτικά 

βίντεο συνοδευμένα παράλληλα και από την γραπτή απεικόνιση της διαδικασίας της γραμμικής 

επεξεργασίας βίντεο θα κάνουν τη γνώση να μεταδοθεί με μεγαλύτερη ευκολία.  

Ως συντάκτης της παρούσας πτυχιακής εργασίας θα έλεγα ότι είμαι αρκετά έμπειρος στο να 

επεξεργάζομαι γραμμικά ένα βίντεο μέσω του «Premiere Pro CC» και θέλω να μεταλαμπαδεύσω τη 

γνώση αυτή και σε άλλους. 

Τα βασικά εργαλεία που χρησιμοποιούνται στην εν λόγω εργασία είναι δύο, το «Premiere Pro CC 2020» 

και το «OBS Studio». Το πρόγραμμα του «Premiere Pro CC» είναι επί πληρωμή μετά τον πρώτο δωρεάν 

μήνα και μπορούμε να το αγοράσουμε συνδρομή στην ιστοσελίδα https://www.adobe.com/gr_en/. 

Επίσης το «Premiere Pro CC 2020» είναι το πρόγραμμα όπου έγινε η γραμμική επεξεργασία των 

εκπαιδευτικών βίντεο. Το δεύτερο πρόγραμμα «OBS Studio», επιλέχτηκε έτσι ώστε να γίνει η 

καταγραφή της οθόνης και της φωνής μου με σκοπό την δημιουργία των εκπαιδευτικών βίντεο ώστε να 

μπορώ μετά να τα επεξεργαστώ και να εξάγω τα τελικά εκπαιδευτικά βίντεο. Το «OBS Studio» είναι 

δωρεάν πρόγραμμα και η λήψη του έγινε από την ιστοσελίδα https://obsproject.com/download .  

Τα τεχνικά χαρακτηριστικά των εκπαιδευτικών βίντεο είναι: 

• Ανάλυση: 2560x1440 pixel 

• Ρυθμός καρέ: 60 καρέ ανά δευτερόλεπτο 

• Format: MP4 Video File 

Μετά την επιλογή των παραπάνω βασικών εργαλείων, δημιουργήθηκε η ανάγκη για την επιλογή της 

ύλης που θα απάρτιζαν τα κεφάλαια της εν λόγω πτυχιακής εργασίας. Η επιλογή και η διάρθρωση της 

ύλης έγινε με γνώμονα τη σωστή κατανομή της ύλης έτσι ώστε σταδιακά να δοθούν οι σωστές 

κατευθύνσεις για να μεταδοθεί η γνώση και να δημιουργηθούν οι συνθήκες όπου ο αναγνώστης/θεατής 

της εν λόγω πτυχιακής εργασίας να είναι σε θέση να επεξεργαστεί γραμμικά ένα βίντεο. Με βάση τα 

παραπάνω, τα κεφάλαια δημιουργήθηκαν ως εξής: 

• «Interface – Εισαγωγή στο Premiere Pro»: έχει ως σκοπό ο χρήστης να μάθει να δημιουργεί 

ένα νέο πρότζεκτ και να μάθει τις αρχικές λειτουργίες στο περιβάλλον του προγράμματος. 

• «Εργαλεία για την επεξεργασία των κλιπ μέσα σε μια ακολουθία (Sequence)»: έχει ως 

σκοπό να μάθει ο χρήστης τα πρώτα βασικά εργαλεία που μας βοηθάνε στην επεξεργασία των 

κλιπ για την δημιουργία του τελικού βίντεο. 

• «Εξαγωγή Βίντεο – Export Settings»: έχει ως σκοπό να μάθουμε τις βασικές ρυθμίσεις 

εξαγωγής ενός τελικού βίντεο. 

https://www.adobe.com/gr_en/
https://obsproject.com/download
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• «Παράθυρο του Effect Controls και Effects»: έχει ως σκοπό την επεξήγηση δύο βασικών 

παραθύρων και λειτουργιών του προγράμματος του «Premiere Pro» για την επεξεργασία των 

κλιπ μέσα στην ακολουθία (sequence). 

• «Χρωματισμός – Coloring»: έχει ως σκοπό να μάθει ο χρήστης πώς να επεξεργαστεί τα 

χρώματα και τις τονικότητες για την διόρθωση ή την καλλιτεχνική όψη της εικόνας του τελικού 

βίντεο. 

• «Βελτιστοποίηση της Προεπισκόπησης»: δίνει λύσεις για την ομαλή λειτουργία του 

προγράμματος έτσι ώστε η αναπαραγωγή των κλιπ μέσα στο πρόγραμμα να γίνεται ομαλά. 

• «Εισαγωγή Τίτλων και Υπότιτλων»: έχει ως σκοπό να μάθει ο χρήστης να προσθέτει απλούς 

ή και δημιουργικούς τίτλους στο τελικό βίντεο καθώς και τον τρόπο προσθήκης και εξαγωγής 

υπότιτλων. 

• «Ο ρόλος των Καρέ ανά δευτερόλεπτο στα βίντεο – Frames per Second»: έχει ως σκοπό ο 

χρήστης να καταλάβει τις διαφορές ανάλογα με τα καρέ του βίντεο στην εισαγωγή των κλιπ 

μέσα στο πρότζεκτ, στην επεξεργασία των κλιπ μέσα στην ακολουθία, καθώς και στην εξαγωγή 

του τελικού μας βίντεο. 

Η ύλη και τα βασικά εργαλεία που χρησιμοποιήθηκαν και αναλύθηκαν παραπάνω αποτελούν τη βασική 

γνώση για να μπορέσει κάποιος να επεξεργαστεί γραμμικά ένα βίντεο και να μπορεί ακόμη και σε 

επαγγελματικό επίπεδο να δημιουργήσει ένα άρτιο αποτέλεσμα. 
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Κεφάλαιο 2ο: Interface – Εισαγωγή στο Premiere Pro CC 

2.1 Εισαγωγή 

Αυτό είναι ένα κεφάλαιο στο οποίο θα γνωρίσουμε το πρόγραμμα του «Premiere Pro CC». Θα 

ξεκινήσουμε από το πρώτο άνοιγμα του προγράμματος και τις επιλογές που έχουμε για να ξεκινήσουμε 

να επεξεργαζόμαστε το πρώτο μας πρότζεκτ. Το πρόγραμμα του «Premiere Pro CC» μπορεί να το βρει 

κανείς στην ιστοσελίδα: www.adobe.com/ . 

2.2 Create a Project.  

Όταν ανοίγουμε το πρόγραμμα του «Premiere Pro CC» μας εμφανίζεται το παράθυρο καλωσορίσματος 

το οποίο στην καρτέλα «Home» μας εμφανίζει τις τρεις επιλογές που μας ενδιαφέρουν για το άνοιγμα 

του προγράμματος.  

 

Εικόνα 1 Παράθυρο Καλωσορίσματος 

Αυτές οι επιλογές είναι: 

• «New Project…»: ανοίγει ένα παράθυρο στο πρόγραμμα μας στο οποίο επιλέγουμε το όνομα 

και την τοποθεσία στον υπολογιστή μας στο οποίο θέλουμε να αποθηκεύσουμε το νέο μας 

«Project» και στην συνέχεια πατάμε «OK». 

http://www.adobe.com/
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Εικόνα 2 Παράθυρο Δημιουργίας «New Project» 

 

• «Open Project…»: ανοίγει ένα παράθυρο στο πρόγραμμα μας στο οποίο επιλέγουμε μέσα από 

τον υπολογιστή μας ένα προ υπάρχον «Project» που έχει την κατάληξη «.prproj». 

 

 

Εικόνα 3 Παράθυρο ανοίγματος υπάρχοντος αρχείου «Project» 
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• «Recent»: κάτω από το «Recent» βλέπουμε τα ονόματα από τα τελευταία «projects» που 

έχουμε ανοίξει στον υπολογιστή μας και μπορούμε να επιλέξουμε όποιο θέλουμε και να το 

«φορτώσει» στον υπολογιστή μας (βλ. Εικόνα 1). 

Όταν πάμε να δημιουργήσουμε ένα νέο «project» (βλ. Εικόνα 2) στην καρτέλα «General» έχουμε την 

επιλογή «Video Rendering and Playback», σε αυτή την επιλογή μας δίνονται έως δύο διαθέσιμες 

επιλογές στο «Renderer». Αυτές οι επιλογές είναι:  

• Mercury Playback Engine GPU Acceleration (CUDA): Το «CUDA» είναι μια αρχιτεκτονική 

– γλώσσα προγραμματισμού για συγκεκριμένη επεξεργασία μέσω της κάρτας γραφικών. Η 

συγκεκριμένη επιλογή για το «Renderer» μας προσφέρει γρηγορότερες ταχύτητες επεξεργασίας 

και κατά συνέπεια επιταχυνόμενες αποδόσεις για την επεξεργασία βίντεο σε πραγματικό χρόνο. 

Αυτή την επιλογή δεν την διαθέτουν όλες οι κάρτες γραφικών που υπάρχουν στο εμπόριο. 

Επίσης πολλές φορές θα πρέπει να έχουμε τις πιο πρόσφατες ενημερώσεις λογισμικού της 

κάρτας γραφικών ώστε να έχουμε την δυνατότητα επιλογής της «CUDA». 

• Mercury Playback Engine Software Only: Όταν η κάρτα γραφικών μας δεν μας παρέχει την 

δυνατότητα της «CUDA» τότε το πρόγραμμα μας θα χρησιμοποιεί την συγκεκριμένη επιλογή 

η οποία έχει λιγότερη αποδοτικότητα. Μία βασική διαφορά είναι ότι με το «CUDA» το 

πρόγραμμα μας, εφόσον διαθέτουμε παραπάνω από μία κάρτα γραφικών, μπορεί να 

αξιοποιήσει για την επεξεργασία όλες τις διαθέσιμες κάρτες γραφικών. Ενώ χωρίς την επιλογή 

της «CUDA» ο υπολογιστής μας θα χρησιμοποιεί στην καλύτερη περίπτωση μία κάρτα 

γραφικών ασχέτως αν διαθέτουμε δύο ή περισσότερες. 

 

Όταν έχουμε την δυνατότητα να επιλέξουμε ανάμεσα στις δύο επιλογές τότε η προτιμότερη επιλογή 

είναι το «CUDA». 

Στην επόμενη καρτέλα «Scratch Disks» έχουμε την δυνατότητα να επιλέξουμε σε ποιο σημείο μέσα 

στον υπολογιστή μας θα αποθηκεύονται τα αρχεία που δημιουργεί αυτόματα το πρόγραμμα για να 

επιταχύνει την επεξεργασία σε πραγματικό χρόνο, παράδειγμα τέτοιων αρχείων είναι το «Video 

Previews» και το «Audio Previews». Επίσης σημαντική είναι και η επιλογή για το που θα 

αποθηκεύονται τα «Project Auto Save» για να μπορούμε να ανατρέξουμε, σε περίπτωση που το 

πρόγραμμα μας κλείσει χωρίς να αποθηκεύσουμε την πρόοδο του «Project», στην πιο πρόσφατη 

αυτόματη αποθήκευση. 
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Εικόνα 4 Καρτέλα «Scratch Disks» 

2.3 Παράθυρο Project στο περιβάλλον εργασίας του «Premiere Pro CC» 

Στο παράθυρο «Project: <Το όνομα του project>» είναι το μέρος στο οποίο προσθέτουμε όλα τα 

αρχεία πολυμέσων που θέλουμε, μερικά από αυτά είναι: τα βίντεο, τα αρχεία ήχου, τα γραφικά, οι 

εικόνες, οι υπότιτλοι κ.α.. Επίσης μπορούμε να διαμορφώσουμε την εμφάνιση είτε την θέση του 

παραθύρου του «Project» ανάλογα με τις προτιμήσεις μας. 

Για να προσθέσουμε τα αρχεία πολυμέσων μέσα στο πρόγραμμα και να εμφανιστούν στο παράθυρο του 

«Project» μπορούμε να πατήσουμε διπλό κλικ μέσα στο χώρο του παραθύρου «Project» στο κενό χώρο 

που γράφει «Import media to start» (βλ. Εικόνα 5), να βρούμε τα αρχεία τα οποία θέλουμε να 

προσθέσουμε και να πατήσουμε «Άνοιγμα» για να προσθέσουμε τα αρχεία ή να πατήσουμε «Import 

Folder» εφόσον θέλουμε να προσθέσουμε έναν φάκελο που περιέχει τα αρχεία πολυμέσων. Ένας άλλος 

τρόπος είναι να πάμε στην γραμμή εργαλείων πάνω αριστερά στο πρόγραμμα και να επιλέξουμε 

File>Import… > (επιλογή αρχείων πολυμέσων ή φακέλου) > Άνοιγμα ή Import Folder. 
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Εικόνα 5 Παράθυρο «Project» 

 

Εικόνα 6 Παράθυρο «Import» 

 

Όταν προσθέσουμε κάποιο αρχείο πολυμέσου στο πρόγραμμα μας εμφανίζεται στο παράθυρο του 

«Project», όταν έχουμε επιλέξει την προβολή των πολυμέσων σε λίστα μας εμφανίζει πρόσθετες 

πληροφορίες για κάθε αρχείο [1]. Ακολουθούν οι ορισμοί για κάθε μία από αυτές τις στήλες: 

• Επιγραφή: Χρώμα που βοηθά στον προσδιορισμό των αρχείων. Μπορούμε να επιλέξουμε το 

χρώμα που θέλουμε. 

• Όνομα/Name: Εμφανίζει το όνομα του αρχείου. Μπορούμε να αλλάξουμε το όνομα του 

αρχείου μέσα στο «Project». 
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• Καρέ/Frame Rate: Εμφανίζει τον αριθμό καρέ ανά δευτερόλεπτο. 

• Αρχή Πολυμέσου/Media Start: Το χρονικό σημείο στο οποίο ξεκινάει το επιλεγμένο κομμάτι 

βίντεο. 

• Τέλος Πολυμέσου/Media End: Το χρονικό σημείο στο οποίο τελειώνει το επιλεγμένο κομμάτι 

βίντεο. 

• Διάρκεια Πολυμέσου/Media Duration: Η διάρκεια του στοιχείου βίντεο ενός κλιπ. Για να 

καθοριστεί η διάρκεια του βίντεο, υπολογίζεται η διαφορά μεταξύ του βίντεο «Αρχή 

Πολυμέσου» και «Τέλος Πολυμέσου». 

• Πληροφορίες Βίντεο/Video Info: Μας δείχνει το μέγεθος της ανάλυσης του αρχείου βίντεο. 

• Πληροφορίες Ήχου/Audio Info: Μας δείχνει πληροφορίες για το κομμάτι ήχου στο αρχείο 

βίντεο. 

 

Εικόνα 7 Στήλες πληροφοριών για τα αρχεία 

 

Στο παράθυρο του «Project» θα δούμε εικονίδια στο κάτω μέρος του τα οποία είναι: 

A. Κλείδωμα / Lock 

B. Προβολή λίστας / List View 

C. Προβολή εικονιδίων / Icon View 

D. Προβολή ελεύθερης μορφής / Freeform View 

E. Ρυθμιστικό Ζουμ / Adjust the size of icons and thumbnails 

F. Αυτοματοποίηση σε σειρά / Automate to sequence 

G. Εύρεση / Find 

H. Νέος Φάκελος / New Bin 

I. Νέο Στοιχείο / New Item 

J. Διαγραφή / Clear 

 

Εικόνα 8 Εικονίδια στο παράθυρο «Project» 
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2.4 Παράθυρο Source και Program στο περιβάλλον εργασίας του «Premiere Pro CC» 

Το «Source Monitor» αναπαράγει μεμονωμένα κλιπ τα οποία ανοίξαμε από το παράθυρο του «Project». 

Στο «Source Monitor» προετοιμάζουμε το κλιπ για να το προσθέσουμε σε μια ακολουθία (Sequence). 

Το «Sequence» θα το αναλύσουμε στο υποκεφάλαιο 2.5. 

Μπορούμε να ορίσουμε σημείο αρχής και σημείο τέλους (In points και Out points) του κλιπ για να 

απομονώσουμε μέρος από το κλιπ που θέλουμε να χρησιμοποιήσουμε για την δημιουργία μιας 

ακολουθίας βίντεο [2]. Για να επισημάνετε ένα σημείο εισόδου σύρετε την κεφαλή αναπαραγωγής 

στο πλαίσιο που θέλετε και στη συνέχεια, κάντε κλικ στο «Mark In»   ή πατήστε το πλήκτρο “I”. 

Για να επισημάνετε ένα σημείο εξόδου σύρετε την κεφαλή αναπαραγωγής στο πλαίσιο που θέλετε και 

στη συνέχεια, κάντε κλικ στο «Mark Out»    ή πατήστε το πλήκτρο “O”. 

Στο παράθυρο του «Source Monitor» έχουμε εργαλεία τα οποία μας βοηθούν στην επεξεργασία του 

κλιπ πριν αυτό προστεθεί στην ακολουθία (Sequence). Αναλυτικότερα οι επιλογές που έχουμε στο 

παράθυρο «Source Monitor» είναι: 

A. Κεφαλή αναπαραγωγής: μας δείχνει το σημείο στο οποίο βρισκόμαστε την συγκεκριμένη 

χρονική στιγμή μέσα στο κλιπ. 

B. Θέση του χρόνου: μας δείχνει σε ποιο χρονικό σημείο βρισκόμαστε την συγκεκριμένη χρονική 

στιγμή. 

C. Ποσοστό μεγέθυνσης/σμίκρυνσης: μας δίνει την επιλογή να ορίσουμε κατά την αναπαραγωγή 

του κλιπ μέσα στο παράθυρο την μεγέθυνση-σμίκρυνση που θέλουμε να βλέπουμε. 

D. Γραμμή κύλισης ζουμ: μας δίνει την επιλογή να αλλάξουμε το μέγεθος της μπάρας του χρόνου 

ώστε να μπορούμε να επιλέξουμε με ευκολία πιο λεπτομερές σημείο χρόνου στο κλιπ. 

E. Εισαγωγή βίντεο: πατώντας το αριστερό κλιπ στο εικονίδιο και σέρνοντας το μέσα σε μία 

ακολουθία (Sequence) μεταφέρουμε μόνο το κομμάτι βίντεο που έχουμε επιλέξει ανάμεσα στα 

σημεία εισόδου και εξόδου «In and Out points». 

F. Εισαγωγή ήχου: πατώντας το αριστερό κλιπ στο εικονίδιο και σέρνοντας το μέσα σε μία 

ακολουθία (Sequence) μεταφέρουμε μόνο το κομμάτι ήχου που έχουμε επιλέξει ανάμεσα στα 

σημεία εισόδου και εξόδου «In and Out points». 

G. Κουμπί ρυθμίσεων: μας εμφανίζει διάφορες ρυθμίσεις που έχουμε για το παράθυρο του 

«Source Monitor». 

H. Διάρκεια εισόδου / εξόδου (In and Out points): μας δείχνει την διάρκεια του επιλεγμένου 

κομματιού βίντεο μέσα στο κλιπ. 

 

Εικόνα 9 Εργαλεία στο παράθυρο «Source Monitor» 

 



Κεφάλαιο 2 

8 

Το «Program Monitor» είναι το παράθυρο παρακολούθησης της ακολουθίας (sequence). Δηλαδή 

αναπαράγει τα κλιπ που βρίσκονται μέσα σε μία ακολουθία (Sequence). Αναλυτικότερα οι επιλογές που 

έχουμε στο παράθυρο «Program Monitor» είναι: 

A. Θέση του χρόνου: μας δείχνει σε ποιο χρονικό σημείο βρισκόμαστε την συγκεκριμένη χρονική 

στιγμή. 

B. Ποσοστό μεγέθυνσης/σμίκρυνσης: μας δίνει την επιλογή να ορίσουμε κατά την αναπαραγωγή 

του κλιπ μέσα στο παράθυρο την μεγέθυνση-σμίκρυνση που θέλουμε να βλέπουμε. 

C. Κεφαλή αναπαραγωγής: μας δείχνει το σημείο στο οποίο βρισκόμαστε την συγκεκριμένη 

χρονική στιγμή μέσα στο κλιπ. 

D. Ανάλυση: μας δίνει την επιλογή να ορίσουμε την ανάλυση στην οποία θα γίνεται η 

αναπαραγωγή. Όσο μικρότερη είναι η ανάλυση αναπαραγωγής τόσο λιγότερο επιβαρύνουμε 

την επεξεργασία στον υπολογιστή μας. 

E. Κουμπί ρυθμίσεων: μας εμφανίζει διάφορες ρυθμίσεις που έχουμε για το παράθυρο του 

«Program Monitor». 

F. Επεξεργαστής κουμπιών: μας δίνει την δυνατότητα να προσθέσουμε επιπλέον εργαλεία στο 

παράθυρο του «Program Monitor». 

 

Εικόνα 10 Εργαλεία στο παράθυρο «Program Monitor» 

 

2.5 Παράθυρο Timeline και δημιουργία Sequence στο περιβάλλον εργασίας του 

«Premiere Pro CC» 

Το παράθυρο του χρονολογίου (Timeline) είναι εκεί όπου ο χρήστης μπορεί να οπτικοποιήσει τις 

ακολουθίες (sequences) και να προσθέσει ή να διαγράψει κομμάτια από τα κλιπ που υπάρχουν στο 

παράθυρο «Project», χωρίς να επηρεάζονται τα αρχεία μέσα στο παράθυρο του «Project». 

Μία ακολουθία (sequence) στο «Premiere Pro CC» είναι απλώς μία οπτική συναρμολόγηση των κλιπ 

ήχου και βίντεο που ο χρήστης τα οργανώνει με όποια σειρά θέλει μέσα στο παράθυρο του χρονολογίου 

(Timeline)[3]. 
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Εικόνα 11 Κενό παράθυρο του «Timeline» 

 

Εικόνα 12 «Sequence» μέσα στο παράθυρο του «Timeline» 

 

Η δημιουργία μίας νέας ακολουθίας (sequence) γίνεται: 

• Στην γραμμή εργαλείων πάνω αριστερά στο πρόγραμμα επιλέγουμε : File > New > 

Sequence….  

• Μόλις το επιλέξουμε μας ανοίγει ένα νέο παράθυρο το «New Sequence» στο οποίο στη 

καρτέλα «Sequence Presets» μπορούμε να επιλέξουμε τις προκαθορισμένες ρυθμίσεις από την 

κάμερα που χρησιμοποιήσαμε για να «γυριστούν» τα κλιπ. Εάν δεν γνωρίζουμε με ποια κάμερα 

έχουν «γυριστεί» τα κλιπ είτε δεν υπάρχει η συγκεκριμένη κάμερα στην λίστα, τότε επιλέγουμε 

μία προκαθορισμένη ρύθμιση στην οποία ταιριάζει με βάση την ανάλυση και των αριθμό καρέ 

που έχουμε στα αρχεία βίντεο. 

• Στην καρτέλα «Settings» μπορούμε να δούμε αναλυτικότερα τις ρυθμίσεις που θα έχει η 

ακολουθία που θα δημιουργήσουμε και να τις επεξεργαστούμε ανάλογα τις προτιμήσεις μας. 

• Στο κάτω μέρος του παραθύρου «New Sequence» έχει την επιλογή «Sequence Name» στην 

οποία επιλέγουμε το όνομα της ακολουθίας (sequence) και πατάμε το «OK» για να 

δημιουργηθεί η ακολουθία μέσα στο «Project» και στη συνέχεια να το προσθέσουμε μέσα στο 

παράθυρο του «Timeline». 
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Εικόνα 13 «New Sequence» και καρτέλα «Sequence Presets» 

 

Εικόνα 14 «New Sequence» και καρτέλα «Settings» 

 



Interface – Εισαγωγή στο Premiere Pro CC 

11 

Ένας εναλλακτικός τρόπος δημιουργίας μιας ακολουθίας είναι να επιλέξουμε ένα αρχείο πολυμέσων 

από το παράθυρο «Project» και να το σύρουμε στο εικονίδιο που βρίσκεται μέσα στο ίδιο παράθυρο 

«New Item» (βλ. Εικόνα 8). Με αυτό τον τρόπο θα δημιουργηθεί μία νέα ακολουθία (sequence) που θα 

έχει διαφορετικό εικονίδιο με το εικονίδιο του κλιπ αλλά με το ίδιο όνομα τις ρυθμίσεις που έχει το 

αρχείο πολυμέσων που επιλέξαμε. Αυτός είναι ένας γρήγορος και εύχρηστος τρόπος για να 

δημιουργήσουμε μία νέα ακολουθία με τις ρυθμίσεις που έχουν τα αρχεία πολυμέσων. Εάν θέλουμε 

αργότερα να αλλάξουμε τις ρυθμίσεις της ακολουθίας (sequence) που δημιουργήσαμε, έχοντας 

επιλεγμένο το αρχείο ακολουθίας (sequence) που θέλουμε μπορούμε να πάμε στην γραμμή εργαλείων 

του προγράμματος πάνω αριστερά και να επιλέξουμε Sequence > Sequence Settings…. Με αυτό τον 

τρόπο θα ανοίξει το παράθυρο με την καρτέλα «Settings» (βλ. Εικόνα 14) και μπορούμε να αλλάξουμε 

τις ρυθμίσεις της ακολουθίας και στην συνέχεια πατάμε το «OK». 

Με την δημιουργία της ακολουθίας (sequence) μπορούμε να προσθέσουμε είτε μέσω του παραθύρου 

«Project» τα αρχεία βίντεο και ήχου επιλέγοντας τα αρχεία και σέρνοντας τα μέσα στο παράθυρο της 

ακολουθίας (sequence), είτε ανοίγοντας ένα-ένα ξεχωριστά τα αρχεία βίντεο και ήχου και μέσω του 

παραθύρου «Source Monitor» να επιλέξουμε συγκεκριμένα κομμάτια από το κλιπ βίντεο ή ήχου και να 

τα προσθέσουμε μέσα στην ακολουθία (sequence). 

Σε αυτό το κεφάλαιο αναλύσαμε τα βήματα για τη δημιουργία ενός νέου «Project» στο «Premiere Pro 

CC» καθώς και τα τέσσερα βασικά παράθυρα (Project, Source Monitor, Program Monitor, Timeline) 

που θα έχουμε κατά την διάρκεια επεξεργασίας και δημιουργίας ενός νέου βίντεο. Επίσης αναλύσαμε 

την δημιουργία μίας νέας ακολουθίας «sequence» στην οποία προσθέτουμε και επεξεργαζόμαστε τα 

αρχεία πολυμέσων που θέλουμε για να δημιουργήσουμε ένα νέο βίντεο. 

 

Εικόνα 15 Το «Interface του Premiere Pro CC» μαζί με τα 4 βασικά παράθυρα  

2.6 Επίλογος 

Σε αυτό το κεφάλαιο είδαμε πώς δημιουργούμε ένα νέο «Project», την διαδικασία προσθήκης των 

πολυμέσων που θέλουμε να επεξεργαστούμε ώστε να δημιουργήσουμε ένα νέο βίντεο στο με την 

δημιουργία μίας νέας ακολουθίας (sequence). Καθώς και τα δύο παράθυρα προεπισκόπησης 

αναπαραγωγής που το ένα είναι το «Source Monitor» για την προεπισκόπηση των κλιπ που 
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προσθέτουμε στο πρόγραμμα μας και το άλλο είναι «Program Monitor» που είναι για την 

προεπισκόπηση της ακολουθίας μας. Στο επόμενο κεφάλαιο θα αναλύσουμε τα βασικά εργαλεία που 

έχουμε για την επεξεργασία των κλιπ μέσα στην ακολουθία μας. 
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Κεφάλαιο 3ο: Εργαλεία για την επεξεργασία των κλιπ μέσα σε 

μια ακολουθία  

3.1 Εισαγωγή 

Σε αυτό το κεφάλαιο θα αναλύσουμε τα βασικά εργαλεία με τα οποία μπορούμε να επεξεργαστούμε 

την ακολουθία μας (sequence)[4]. 

3.2 Βασικά Εργαλεία 

Το εργαλείο επιλογής (Selection Tool) με συντόμευση πληκτρολογίου το “V” είναι το εργαλείο με το 

οποίο ο χρήστης μπορεί να επιλέξει οτιδήποτε υπάρχει μέσα στο πρόγραμμα του «Premiere Pro». Η 

επιλογή κάθε φορά του σωστού παραθύρου ή αρχείου μέσα στο πρόγραμμα είναι σημαντική διότι το 

πρόγραμμα θα μπορεί να εκτελέσει λειτουργίες μόνο στα επιλεγμένα στοιχεία.  

Παράδειγμα: Εάν θέλουμε να πάμε στην γραμμή εργαλείων του «Premiere Pro» πάνω αριστερά και να 

επιλέξουμε Sequence > Sequence Settings… , θα πρέπει να έχουμε επιλεγμένο μέσα από το παράθυρο 

του «Project» ή μέσα στο παράθυρο του «Timeline» ένα αρχείο ακολουθίας (sequence), σε διαφορετική 

περίπτωση το «Premiere Pro» δεν θα μας έχει διαθέσιμη την επιλογή για το «Sequence Settings» καθώς 

δεν γνωρίζει σε ποια ακριβώς ακολουθία, που έχουμε δημιουργήσει, θέλουμε να κάνουμε τις αλλαγές. 

 

Εικόνα 16 Εργαλείο Επιλογής - «Selection Tool» 

Το εργαλείο «Track Select Forward Tool» με συντόμευση πληκτρολογίου το “A” είναι το εργαλείο 

το οποίο ο δείκτης του ποντικιού εμφανίζει δύο μαύρα βέλη που κοιτάνε προς τα δεξιά. Αν 

μετακινήσουμε αυτά τα δύο βέλη μέσα στην ακολουθία (sequence) και πατήσουμε το αριστερό κλικ, 

τότε όλα τα στοιχεία που βρίσκονται από το σημείο του κέρσορα και δεξιά θα επιλεγούν και με αυτό 

τον τρόπο μπορούμε εύκολα να μετακινήσουμε πολλαπλά στοιχεία ή να τα αντιγράψουμε ή να τα 

σβήσουμε. Όλα τα στοιχεία που βρίσκονται αριστερά από αυτά τα δύο βέλη δεν θα επιλεγούν. 

Σε περίπτωση που θέλουμε να επιλέξουμε συγκεκριμένο «track» μέσα στην ακολουθία κρατώντας το 

πλήκτρο “shift” από το πληκτρολόγιο ο δείκτης του ποντικιού εμφανίζει μόνο ένα μαύρο βέλος που 

κοιτάει προς τα δεξιά και πηγαίνοντας  στο συγκεκριμένο κανάλι (track), (τα ονόματα από τα «video 

και audio tracks» είναι το V1,V2,…Vi και A1,A2,…Ai), που θέλουμε να επιλέξουμε, πατώντας 

αριστερό κλικ, επιλέγονται όλα τα στοιχεία από το βέλος και δεξιά που βρίσκονται στο «track» που 

έχουμε τον κέρσορα από το ποντίκι. 

Σε περίπτωση που θέλουμε να επιλέξουμε στοιχεία τα οποία είναι από ένα σημείου της ακολουθίας 

(sequence) και αριστερά τότε έχοντας ήδη επιλεγμένο το εργαλείο «Track Select Forward Tool» 

πατώντας το πλήκτρο “shift” και στην συνέχεια το πλήκτρο “A” από το πληκτρολόγιο τα βέλη αλλάζουν 

κατεύθυνση και κοιτάνε προς τα αριστερά. Οπότε όταν πατήσουμε αριστερό κλικ στο ποντίκι θα 

επιλέξει όλα τα στοιχεία μέσα στην ακολουθία τα οποία είναι από το σημείο του κέρσορα και αριστερά 

όλα τα υπόλοιπα στοιχεία δεν θα επιλεγούν. 
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Εικόνα 17 «Track Select Forward Tool» 

 

Εικόνα 18 Τα διαφορετικά «Tracks» μέσα σε μία ακολουθία (Sequence) 

Το εργαλείο Περικοπής «Ripple Edit Tool» με συντόμευση πληκτρολογίου το “B” είναι ένα εργαλείο 

με το οποίο πηγαίνοντας τον κέρσορα του ποντικιού στην αρχή ή στο τέλος από ένα κλιπ μέσα στην 

ακολουθία (sequence) και κρατώντας το αριστερό κλικ μπορούμε να κόψουμε το σημείο αρχής ή τέλους 

από το κλιπ σέρνοντας προς τα δεξιά αν επιλέξουμε το σημείο εισόδου είτε σέρνοντας προς τα αριστερά 

αν επιλέξουμε το σημείο εξόδου. Ουσιαστικά μας επιτρέπει να «κόψουμε» το κλιπ μέσα στην 

ακολουθία. 

 

Εικόνα 19 Εργαλείο Περικοπής «Ripple Edit Tool» 

Το εργαλείο Ξυραφιού «Razor Tool» με συντόμευση πληκτρολογίου το “C” είναι ένα εργαλείο το 

οποίο χρησιμοποιείται για να κόψει ένα κλιπ. Πηγαίνοντας το ποντίκι στο σημείο που θέλουμε να 

κόψουμε, πατώντας το αριστερό κλικ κόβει το κλιπ σε εκείνο ακριβώς το σημείο οπότε μετά έχουμε 

δύο ξεχωριστά κλιπ για να τα επεξεργαστούμε σαν δύο διαφορετικά στοιχεία μέσα στην ακολουθία 

(sequence). 

 

Εικόνα 20 Εργαλείο Ξυραφιού «Razor Tool» 

Το εργαλείο Πένας «Pen Tool» με συντόμευση πληκτρολογίου το “P” είναι ένα εργαλείο το οποίο 

επιτρέπει να προσθέτουμε σημεία μέσα σε ένα κλιπ (keyframes). Σε αυτά τα σημεία μπορούμε να 
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κάνουμε πολλές μετατροπές. Μερικές από τις πιο συνηθισμένες επιλογές είναι να αλλάξουμε την 

αδιαφάνεια, το μέγεθος, την θέση είτε και την ένταση του ήχου, μέσα σε ένα κλιπ. 

 

Εικόνα 21 Εργαλείο Πένας «Pen Tool» 

Το εργαλείο Χεριού «Hand Tool» με συντόμευση πληκτρολογίου το “H” είναι ένα εργαλείο το οποίο 

μας επιτρέπει να μετακινηθούμε μπροστά ή πίσω μέσα στο χρονολόγιο (timeline). Μπορούμε εύκολα 

να μετακινηθούμε κατά μήκος της λωρίδας του χρόνου κρατώντας το αριστερό κλικ και μετακινώντας 

το ποντίκι δεξιά ή αριστερά. Είναι αρκετά βοηθητικό εργαλείο όταν θέλουμε να εντοπίσουμε ακριβή 

κλιπ ή καρέ. 

 

Εικόνα 22 Εργαλείο χεριού «Hand Tool» 

Με το εργαλείο Πληκτρολόγησης «Type Tool» με συντόμευση πληκτρολογίου το “T” είναι ένα 

εργαλείο το οποίο το χρησιμοποιούμε όταν θέλουμε να γράψουμε ένα κείμενο που θα προστεθεί μέσα 

στην ακολουθία (sequence) που θέλουμε. Ο τρόπος για να προστεθεί το κείμενο είναι να επιλέξουμε το 

εργαλείο πληκτρολόγησης «Type Tool», να έχουμε την κεφαλή αναπαραγωγής στο σημείο του κλιπ 

στο οποίο θέλουμε να προστεθεί ένα κείμενο και να πάμε στο παράθυρο «Program Source» και να 

πατήσουμε αριστερό κλικ επάνω στην εικόνα στο σημείο που θέλουμε να προσθέσουμε το κείμενο. Στη 

συνέχεια πληκτρολογούμε το κείμενο και μόλις ολοκληρώσουμε την πληκτρολόγηση πατάμε αριστερό 

κλικ μέσα σε ένα κενό σημείο μέσα στο παράθυρο του χρονολογίου (timeline). Με αυτό τον τρόπο 

δημιουργείτε ένα καινούργιο γραφικό στοιχείο μέσα στην ακολουθία (sequence) που στην συνέχεια 

μπορούμε να το επεξεργαστούμε όπως θέλουμε. 

 

Εικόνα 23 Εργαλείο πληκτρολόγησης «Type Tool» 

 

3.3 Βασικά Εργαλεία μέσα σε μία ακολουθία (Sequence) 

Όταν δημιουργούμε μία καινούργια ακολουθία (sequence) στο παράθυρο του χρονολογίου (timeline) 

έχουμε μερικά πολύ χρήσιμα εργαλεία. 

Το εργαλείο «Snap in timeline» με συντόμευση πληκτρολογίου το “S”. Για να ενεργοποιήσουμε ή να 

το απενεργοποιήσουμε πατάμε το εικονίδιο του εργαλείου πάνω αριστερά στο παράθυρο του 

χρονολογίου (timeline). Όταν το έχουμε ενεργοποιημένο σέρνοντας ένα κλιπ μέσα στην ακολουθία 

(sequence) ενώ προϋπάρχει ένα ή περισσότερα κλιπ, μόλις πλησιάσουμε το ένα κλιπ κοντά στο άλλο, 

αυτόματα θα «κολλήσει» η αρχή του ενός κλιπ με το τέλος του άλλου και θα εμφανιστεί μία κάθετη 

γραμμή με βέλη μέσα στην ακολουθία (sequence). Με αυτό τον τρόπο μπορούμε εύκολα να ενώσουμε 

διαφορετικά κλιπ μεταξύ τους χωρίς να έχουμε τον κίνδυνο το ένα κλιπ να υπερκαλύψει το άλλο. 
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Εικόνα 24 Εργαλείο «Snap in timeline» 

Το εργαλείο «Timeline Display Settings» βρίσκεται πάνω αριστερά στο παράθυρο του χρονολογίου 

(timeline) και μας παρέχει πολλές επιλογές για το τι θα μας εμφανίζει μέσα σε μία ακολουθία 

(sequence). 

 

Εικόνα 25 Εργαλείο «Timeline Display Settings» 

Το εργαλείο «Toggle Track Output» βρίσκεται δεξιά από το όνομα κάθε καναλιού «track» μέσα σε 

κάθε ακολουθία (sequence) και το εικονίδιο έχει το σχήμα ενός ματιού. Όταν πατήσουμε επάνω στο 

εικονίδιο εμφανίζεται μία διαγώνια γραμμή η οποία υποδηλώνει ότι το συγκεκριμένο κανάλι «track» 

έχει απενεργοποιηθεί. Οπότε οτιδήποτε υπάρχει μέσα στην ακολουθία (sequence) στο κανάλι που είναι 

απενεργοποιημένο δεν θα εμφανίζεται στην αναπαραγωγή. 

 

Εικόνα 26 Εργαλείο «Toggle Track Output» 

Το εργαλείο κλειδαριάς «Toggle Track Lock» βρίσκεται αριστερά από το όνομα κάθε καναλιού 

«track» μέσα σε κάθε ακολουθία (sequence) και το εικονίδιο έχει το σχήμα μιας ανοιχτής κλειδαριάς. 

Όταν πατήσουμε το εικονίδιο με το αριστερό κλικ τότε το εικονίδιο γίνεται μπλε και η κλειδαριά 

φαίνεται κλειδωμένη.  
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Εικόνα 27 Εργαλείο κλειδαριάς «Toggle Track Lock» 

Στο κανάλι που ενεργοποιούμε το «Toggle Track Lock» εμφανίζονται διακεκομμένες γραμμές μέσα 

στην ακολουθία (sequence) και αυτό υποδηλώνει ότι το συγκεκριμένο κανάλι δεν μπορεί να υποστεί 

καμία επεξεργασία. 

 

Εικόνα 28 Εργαλείο κλειδαριάς «Toggle Track Lock» ενεργοποιημένο 

Το εργαλείο σίγασης «Mute Track» είναι το αντίστοιχο εργαλείο με το «Toggle Track Output» που 

έχουμε για τα κανάλια βίντεο (βλ. Εικόνα 26). Το εργαλείο σίγασης βρίσκεται δεξιά από τα ονόματα 

των καναλιών ήχου και έχει το γράμμα “M” για εικονίδιο. Όταν το ενεργοποιήσουμε το χρώμα του 

γίνεται πράσινο και αυτό μας υποδηλώνει ότι στο κανάλι που ενεργοποιήθηκε το κανάλι ήχου θα μείνει 

ανενεργό.  
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Εικόνα 29 Εργαλείο σίγασης «Mute Track» 

Το εργαλείο «Solo Track» βρίσκεται δεξιά από τα ονόματα των καναλιών ήχου και έχει το γράμμα 

“S” για εικονίδιο. Όταν το ενεργοποιήσουμε το χρώμα του γίνεται κίτρινο. Με το συγκεκριμένο 

εργαλείο μπορούμε να απομονώσουμε τα κανάλια ήχου που θέλουμε να ακούμε. Για παράδειγμα, αν 

υπάρχουν δέκα ενεργά κανάλια ήχου μέσα στην ακολουθία μας και εμείς θέλουμε να ακούσουμε μόνο 

τα δύο από αυτά, τότε αντί να χρησιμοποιήσουμε το εργαλείο σίγασης για τα οχτώ κανάλια, θα 

χρησιμοποιήσουμε το εργαλείο «Solo Track» στα δύο κανάλια που θέλουμε να ακούσουμε. Με αυτό 

τον τρόπο θα ακούμε μόνο τα κανάλια που υπάρχει ενεργοποιημένο το εργαλείο «Solo Track». 

 

Εικόνα 30 Εργαλείο «Solo Track» 

3.4 Επιλογές για τα κλιπ μέσα σε μια ακολουθία (Sequence) και επιλογή των 

συντομεύσεων πληκτρολογίου 

Για κάθε ένα κλιπ που προστίθεται μέσα σε μια ακολουθία ο χρήστης έχει την δυνατότητα να το 

επεξεργαστεί με πολλούς τρόπους χωρίς να επηρεάζεται το αρχικό κλιπ που έχει προσθέσει στο 

«project». Η κάθε αλλαγή θα γίνεται μόνο μέσα στην ακολουθία που βρίσκεται το κλιπ. Πατώντας δεξί 

κλικ πάνω σε κάποιο κλιπ εμφανίζεται μια λίστα με εργαλεία που βοηθούν στην επεξεργασία των κλιπ 

μέσα στην ακολουθία. Τα βασικότερα εργαλεία μαζί με τους ορισμούς τους είναι τα εξής: 
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• Αποκοπή / Cut: αφαιρεί όλο το επιλεγμένο κλιπ μέσα από την ακολουθία και παραμένει στην 

προσωρινή μνήμη του προγράμματος ως τελευταίο στοιχείο προς επικόλληση. 

• Αντιγραφή / Copy: αντιγράφει όλο το επιλεγμένο κλιπ μέσα από την ακολουθία και παραμένει 

στην προσωρινή μνήμη του προγράμματος ως τελευταίο στοιχείο προς επικόλληση. 

• Κατάργηση Εφέ / Remove Attributes : ανοίγει ένα νέο παράθυρο διαλόγου που μας επιτρέπει 

να επιλέξουμε τους τύπους εφέ που θέλουμε να καταργήσουμε και στην συνέχεια κάνουμε κλικ 

στο «OK». 

• Ενεργοποιημένο / Enable: απενεργοποιεί ή ενεργοποιεί ένα κλιπ. Η απενεργοποίηση ενός κλιπ 

το αποκρύπτει όταν θα κάνουμε αναπαραγωγή την ακολουθία ή όταν θα κάνουμε εξαγωγή του 

τελικού βίντεο. Βέβαια ένα απενεργοποιημένο κλιπ μπορεί να μετακινηθεί να διαγραφεί ή 

ακόμη και να εφαρμόσουμε άλλες αλλαγές σε αυτό.  

• Σύνδεση-Αποσύνδεση / Link-Unlink: Τα περισσότερα κλιπ περιέχουν και βίντεο και ήχο και 

εμφανίζονται ως ένα μόνο στοιχείο. Όταν προσθέσουμε το κλιπ σε μια ακολουθία το βίντεο και 

ο ήχος εμφανίζονται σε ξεχωριστά κομμάτια με το βίντεο ακριβώς πάνω από τον ήχο (κανάλια 

βίντεο – κανάλια ήχου). Το βίντεο και ο ήχος παραμένουν συνδεδεμένα. Όταν σύρουμε το 

τμήμα βίντεο μέσα στην ακολουθία τότε ο συνδεδεμένος ήχος μετακινείται μαζί του και 

αντίστροφα. Όλες οι εργασίες επεξεργασίας ενεργούν και στα δύο μέρη ενός συνδεδεμένου 

κλιπ. Για να αποσυνδέσουμε ένα κλιπ βίντεο και ήχου, επιλέγουμε το κλιπ και στην συνέχεια 

δεξί κλικ > «Unlink». Για να συνδέσουμε κλιπ βίντεο και ήχου, κρατώντας το πλήκτρο «Shift» 

επιλέγουμε τα δύο μέρη (βίντεο και ήχο) και πατάμε δεξί κλικ > «Link». 

• Ετικέτα / Label: αλλάζει το χρώμα που εμφανίζονται τα κλιπ μέσα σε μια ακολουθία. Είναι 

μια χρήσιμη επιλογή όταν θέλουμε να ομαδοποιήσουμε/κατηγοριοποιήσουμε κάποια κλιπ 

μεταξύ τους για να τα αναγνωρίζουμε πιο εύκολα. Για παράδειγμα, αν έχουμε μερικά κλιπ 

συνέντευξης και μερικά κλιπ γενικών πλάνων, μπορούμε τα κλιπ με την συνέντευξη να τα 

βλέπουμε με το χρώμα “μπλε” μέσα στην ακολουθία και τα κλιπ με τα γενικά πλάνα να τα 

βλέπουμε με το χρώμα “κίτρινο”. 

• Ταχύτητα-Διάρκεια / Speed-Duration: η ταχύτητα ενός κλιπ είναι ο ρυθμός με τον οποίο 

αναπαράγεται σε σύγκριση με τον ρυθμό με τον οποίο καταγράφτηκε. Η διάρκεια ενός κλιπ 

είναι το χρονικό διάστημα που απαιτείται για την αναπαραγωγή από το σημείο εισόδου έως το 

σημείο εξόδου. Με την επιλογή Ταχύτητα-Διάρκεια μπορούμε να επιταχύνουμε ή να 

επιβραδύνουμε την ταχύτητα αναπαραγωγής. Όταν επιλέξουμε αυτή την επιλογή σε ένα κλιπ 

θα μας εμφανίσει ένα παράθυρο διαλόγου στο οποίο μπορούμε να ορίσουμε το ποσοστό 

ταχύτητας αναπαραγωγής. Επίσης μία χρήσιμη επιλογή σε αυτό το παράθυρο διαλόγου είναι η 

Αντίστροφη Ταχύτητα «Reverse Speed» που μας επιτρέπει να αναπαράγουμε τα κλιπ προς 

τα πίσω (ανάποδα). 

• Εμφάνιση στο πρότζεκτ / Reveal in project: όταν έχουμε ένα κλιπ μέσα σε μια ακολουθία 

αλλά θέλουμε να δούμε από ποιο αρχείο μέσα στο πρότζεκτ προέρχεται αυτό το κλιπ, 

επιλέγουμε το «Reveal in project». Αυτή η επιλογή μας δείχνει μέσα στο παράθυρο του 

«Project» που ακριβώς βρίσκεται το αρχικό κλιπ που επιλέξαμε μέσα στην ακολουθία. 

• Εμφάνιση στην αναζήτηση / Reveal in Explorer: αυτή η επιλογή κάνει ακριβώς ό,τι και το 

«Reveal in project», μόνο που αυτή την φορά μας εμφανίζει που βρίσκεται το κλιπ μέσα στον 

υπολογιστή μας και όχι μέσα στο πρόγραμμα του «Premiere Pro CC». 

• Ιδιότητες / Properties: μας εμφανίζει ένα καινούργιο παράθυρο διαλόγου το οποίο μας δείχνει 

τις ιδιότητες που έχει το κλιπ που επιλέξαμε. Μερικές από τις ιδιότητες που μας δείχνει είναι ο 

τύπος της συμπίεσης, το μέγεθος, η ανάλυση και ο ρυθμός καρέ ανά δευτερόλεπτο του κλιπ. 
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Εικόνα 31 Επιλογές των κλιπ μέσα σε μια ακολουθία 

Οι συντομεύσεις πληκτρολογίου μειώνουν αισθητά τον χρόνο που χρειάζεται για να επεξεργαστούμε 

τα κλιπ μέσα στην ακολουθία και έχει ως συνέπεια την γρηγορότερη υλοποίηση του τελικού μας βίντεο. 

Για να δούμε όλες τις συντομεύσεις πληκτρολογίου που υπάρχουν πηγαίνουμε στο κεντρικό μενού 

πάνω αριστερά στο πρόγραμμα και επιλέγουμε Edit > Keyboard Shortcuts…. Στην συνέχεια μας 

εμφανίζει ένα νέο παράθυρο διαλόγου στο οποίο μας εμφανίζει όλες τις συντομεύσεις πληκτρολογίου 

και την δυνατότητα είτε να αλλάξουμε μία συντόμευση είτε να προσθέσουμε καινούργιες δικές μας 

συντομεύσεις πληκτρολογίου.  

 

Εικόνα 32 Παράθυρο συντομεύσεων πληκτρολογίου 
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3.5 Επίλογος 

Σε αυτό το κεφάλαιο είδαμε τα βασικά εργαλεία τα οποία μας προσφέρει το «Premiere Pro CC» στο 

παράθυρο του «Timeline» για την επεξεργασία μιας ακολουθίας. Επίσης είδαμε τις βασικές επιλογές 

εργαλείων που έχουμε σε κάθε κλιπ μέσα στην ακολουθία. Τέλος είδαμε και το παράθυρο διαλόγου των 

συντομεύσεων πληκτρολογίου στο οποίο μπορούμε να αλλάξουμε τα πλήκτρα συντομεύσεων ή να 

προσθέσουμε τα δικά μας. Στο επόμενο κεφάλαιο θα δούμε τις βασικές επιλογές για να μπορέσουμε να 

εξάγουμε (export) το τελικό μας βίντεο.
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Κεφάλαιο 4ο: Εξαγωγή Βίντεο - Export Settings 

4.1 Εισαγωγή 

Μέχρι στιγμής έχουμε εξηγήσει τα τέσσερα βασικά παράθυρα που χρησιμοποιούμε για να προσθέσουμε 

το οπτικοακουστικό υλικό και να το επεξεργαστούμε μέσα σε μια ακολουθία. 

4.2 Επιλογές για την Εξαγωγή Βίντεο 

Μόλις τελειώσουμε την επεξεργασία μέσα στην ακολουθία και θέλουμε να εξάγουμε το τελικό βίντεο 

ακολουθούμε την εξής διαδικασία[5]: 

1. Πηγαίνουμε την κεφαλή αναπαραγωγής μέσα στην ακολουθία (sequence) στο σημείο έναρξης 

που θέλουμε να έχει το τελικό μας βίντεο. Πατάμε μέσα στο παράθυρο του χρονολογίου 

(timeline) και πάνω στην μπάρα του χρόνου δεξί κλικ > Mark In ή διαφορετικά το πλήκτρο 

συντόμευσης “I” για να ορίσουμε το σημείο έναρξης του τελικού μας βίντεο.  

 

Εικόνα 33 Κεφαλή αναπαραγωγής και ορισμός σημείου έναρξης μέσα στην ακολουθία 

2. Πηγαίνουμε την κεφαλή αναπαραγωγής μέσα στην ακολουθία (sequence) στο σημείο λήξης 

που θέλουμε να έχει το τελικό μας βίντεο. Πατάμε μέσα στο παράθυρο του χρονολογίου 

(timeline) και πάνω στην μπάρα του χρόνου δεξί κλικ > Mark Out ή διαφορετικά το πλήκτρο 

συντόμευσης “O” για να ορίσουμε το σημείο λήξης του τελικού μας βίντεο. 
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Εικόνα 34 Κεφαλή αναπαραγωγής και ορισμός σημείου λήξης μέσα στην ακολουθία 

3. Για να ορίσουμε νέο σημείο έναρξης ή λήξης του βίντεο τοποθετούμε την κεφαλή 

αναπαραγωγής στο νέο σημείο και επαναλαμβάνουμε την διαδικασία από το 1 ή 2. Σε 

περίπτωση που θέλουμε να σβήσουμε τα σημεία έναρξης και λήξης μέσα από την ακολουθία, 

πατάμε μέσα στο παράθυρο του χρονολογίου (timeline) και πάνω στην μπάρα του χρόνου δεξί 

κλικ > Clear In ή Clear Out ή Clear In and Out. 

4. Έχοντας επιλεγμένο το παράθυρο του χρονολογίου (timeline) και την ακολουθία στην οποία 

έχουμε το τελικό βίντεο που θέλουμε να εξάγουμε. Πατάμε στην γραμμή εργαλείων πάνω 

αριστερά File > Export > Media… ή διαφορετικά το πλήκτρο συντόμευσης “Ctrl+M” και μας 

ανοίγει ένα νέο παράθυρο διαλόγου το «Export Settings» στο οποίο θα ορίσουμε τις ρυθμίσεις 

που θέλουμε να έχει το τελικό μας βίντεο στην εξαγωγή του. 

 

Εικόνα 35 Παράθυρο διαλόγου «Export Settings» 

5. Στην συνέχεια πάνω δεξιά στο παράθυρο «Export Settings» επιλέγουμε τον τύπο συμπίεσης 

«Format» που θέλουμε να έχει το βίντεο που θα εξάγουμε. Η πιο συχνή επιλογή είναι η 
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συμπίεση “mp4” και η ονομασία μέσα στο «Premiere Pro CC» είναι η “H.264”. Βέβαια στην 

λίστα θα βρούμε πολλές διαφορετικές επιλογές και επιλέγουμε ανάλογα τις ανάγκες μας. 

 

Εικόνα 36 Λίστα συμπιέσεων «Format» 

6. Στην συνέχεια ακριβώς από κάτω στην λίστα «Preset» επιλέγουμε την ανάλυση που θέλουμε 

να έχει το βίντεο που θα κάνουμε εξαγωγή. Πρέπει να τονίσουμε ότι η ανάλυση που θα έχει το 

τελικό βίντεο στην εξαγωγή του δεν είναι χρειάζεται να είναι η ίδια με την ανάλυση που είχαμε 

στις ρυθμίσεις της ακολουθίας (sequence). Δηλαδή μπορούμε να έχουμε μία ανάλυση 

3840px2160p στην ακολουθία (sequence) και στο τελικό βίντεο να εξάγουμε ένα βίντεο με 

ανάλυση 1920px1080p. 

 

Εικόνα 37 Λίστα «Preset» 
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7. Στην συνέχεια βλέπουμε την επιλογή «Output Name» στην οποία υπάρχει ήδη ένα όνομα 

αρχείου για το τελικό βίντεο που είναι το ίδιο με το όνομα της ακολουθίας που βρίσκεται το 

τελικό βίντεο. Πατώντας αριστερό κλικ πάνω στο όνομα μας εμφανίζει ένα νέο παράθυρο του 

υπολογιστή μας στο οποίο μπορούμε να αλλάξουμε το όνομα που θέλουμε να έχει το τελικό 

βίντεο καθώς και την θέση που θα αποθηκευτεί μέσα στον υπολογιστή μας. 

8. Από κάτω έχουμε δύο ακόμη επιλογές το «Export Video» και το «Export Audio». Από 

προεπιλογή το πρόγραμμα έχει τσεκαρισμένα και τα δύο κουτιά δίπλα σε αυτές τις επιλογές. 

Εάν θέλουμε το τελικό βίντεο εξαγωγής να μην περιέχει είτε το βίντεο είτε τον ήχο τότε 

πατώντας αριστερό κλικ στο αντίστοιχο κουτάκι αφαιρούμε είτε το βίντεο είτε τον ήχο από το 

τελικό βίντεο που θα εξάγουμε. 

9. Στην συνέχεια βλέπουμε ένα πλαίσιο το «Summary». Σε αυτό το πλαίσιο μας δίνει τις 

πληροφορίες που έχουμε για το «Output», δηλαδή για το αρχείο που θα κάνει εξαγωγή το 

«Premiere Pro CC», και τις πληροφορίες που έχουμε για το «Source», δηλαδή μας δείχνει τις 

βασικές ρυθμίσεις που έχει η ακολουθία (sequence) που περιέχει τα κλιπ που θα 

χρησιμοποιήσει για την εξαγωγή του τελικού βίντεο. 

 

Εικόνα 38 «Output Name», «Export Video – Audio», «Summary» 

10. Στην συνέχεια πάμε στην καρτέλα «Video» και πηγαίνουμε στο «Bitrate Settings». Εκεί 

βρίσκουμε την λίστα «Bitrate Encoding» που μας έχει τρεις επιλογές ανάλογα με την ποιότητα 

που θέλουμε να έχει το βίντεο με βάση το «bitrate»: 

a. CBR: με αυτή την επιλογή το πρόγραμμα θα κρατήσει σταθερό ρυθμό μετάδοσης bit 

σε όλη την διάρκεια του τελικού βίντεο κατά την εξαγωγή. 

b. VBR, 1 pass: με αυτή την επιλογή το πρόγραμμα θα χρησιμοποιήσει μεταβλητό αριθμό 

μετάδοσης bit (περισσότερος ρυθμός μετάδοσης bit όταν υπάρχει έντονη κίνηση της 

εικόνας στο βίντεο, λιγότερος ρυθμός μετάδοσης bit όταν υπάρχει στατική εικόνα στο 

βίντεο). 

c. VBR, 2 pass: με αυτή την επιλογή το πρόγραμμα θα κάνει δύο φορές το πέρασμα του 

βίντεο κατά την εξαγωγή. Στο πρώτο πέρασμα υπολογίζει και αντιστοιχεί σε κάθε 



Κεφάλαιο 4 

26 

σημείο τον βέλτιστο ρυθμό μετάδοσης bit που χρειάζεται και με το δεύτερο πέρασμα 

εξάγει το βίντεο (χρειάζεται τον διπλάσιο χρόνο εξαγωγής από την επιλογή VBR, 1 

pass). 

 

Εικόνα 39 «Bitrate Settings», «Bitrate Encoding» 

11. Στην συνέχεια στο κάτω δεξιά μέρος του παραθύρου «Export Settings» βρίσκεται το κουμπί 

«Export». Κάνοντας αριστερό κλικ στο «Export» ξεκινάει η επεξεργασία για την εξαγωγή του 

τελικού βίντεο. Μόλις τελειώσει η διαδικασία το βίντεο θα βρίσκεται μέσα στον υπολογιστή 

μας στο σημείο που επιλέξαμε στο βήμα 7. 

 

Εικόνα 40 Εξαγωγή του τελικού βίντεο 

4.3 Επίλογος 

Σε αυτό το κεφάλαιο είδαμε τις βασικές επιλογές που έχουμε για την εξαγωγή ενός τελικού βίντεο. 

Αναλύσαμε τις βασικές ρυθμίσεις στο παράθυρο διαλόγου «Export Settings». Στο επόμενο κεφάλαιο 

θα δούμε ένα νέο παράθυρο το «Effect Controls», τα βασικά εφέ που βρίσκουμε σε κάθε κλιπ καθώς 

και τα εφέ που μπορούμε να προσθέσουμε εμείς μαζί με τις ιδιαιτερότητες του. 
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Κεφάλαιο 5ο: Παράθυρο των «Effect Controls» και «Effects» 

5.1 Εισαγωγή 

Το παράθυρο «Effect Controls» βρίσκεται από προεπιλογή στο πάνω αριστερά παράθυρο δίπλα από 

την καρτέλα «Source» (οθόνη προεπισκόπησης). Σε περίπτωση που η καρτέλα δεν υπάρχει ανοιχτή τότε 

από την γραμμή εργαλείων πάνω αριστερά στο «Premiere Pro CC» κάνουμε κλικ στο Window > Effect 

Controls.  

Το παράθυρο «Effect Controls» εμφανίζει τα εφέ για το τρέχον επιλεγμένο κλιπ μέσα στην ακολουθία 

(sequence). Καθώς επιλέγουμε διαφορετικά κλιπ, το παράθυρο «Effect Controls» θα αλλάζει και θα 

εμφανίζει τα εφαρμοσμένα εφέ για κάθε ένα κλιπ ξεχωριστά. 

5.2 Σταθερά Εφέ 

Για κάθε ένα κλιπ υπάρχουν τα σταθερά εφέ που εφαρμόζονται αυτόματα σε κάθε κλιπ, όπως είναι το 

«Motion» και το «Opacity» για τα κλιπ βίντεο και το «Volume» για τα κλιπ ήχου. Τα σταθερά εφέ 

παίρνουν αυτόματα τις αρχικές τιμές τους αλλά στην συνέχεια μπορούμε να τις παραμετροποιήσουμε. 

Τα εφέ μπορεί να είναι τα ίδια σε όλο το κλιπ ή μπορούν να ρυθμιστούν ώστε να αλλάζουν με την 

πάροδο του χρόνου. Την κάθε αλλαγή μέσα στο ίδιο κλιπ την κάνουμε με την βοήθεια των «Keyframes» 

[6]. Μπορούμε να προσθέσουμε «Keyframes» για κάθε ένα καρέ μέσα στο κλιπ και για κάθε ένα 

ξεχωριστό εφέ. 

Αναλυτικότερα τα σταθερά εφέ σε κάθε κλιπ για την εικόνα-βίντεο είναι: 

• «Motion»: στην ενότητα «Motion» μπορούμε να αλλάξουμε την θέση της εικόνας του κλιπ, να 

αλλάξουμε το μέγεθος (μεγέθυνση-σμίκρυνση), και να περιστρέψουμε την εικόνα. 

Αναλυτικότερα τα βασικότερα σταθερά εφέ που έχουμε είναι: 

• «Position»: μας δίνει τη δυνατότητα να αλλάξουμε την θέση της εικόνας του κλιπ μέσα στην 

ακολουθία (sequence). 

• «Scale»: μας δίνει τη δυνατότητα να αλλάξουμε το μέγεθος της εικόνας του κλιπ μέσα στην 

ακολουθία (sequence). 

• «Rotation»: μας δίνει τη δυνατότητα να περιστρέψουμε την εικόνα του κλιπ μέσα στην 

ακολουθία (sequence). 

• «Opacity»: στην ενότητα «Opacity» μπορούμε να αλλάξουμε την αδιαφάνεια ολόκληρης της 

εικόνας του κλιπ ή εναλλακτικά μπορούμε να χρησιμοποιήσουμε τα βοηθητικά σχήματα ή το 

εργαλείο της πένας (Pen Tool) για να επιλέξουμε συγκεκριμένο τμήμα της εικόνας ώστε να 

αλλάξουμε την αδιαφάνεια του. 

Αναλυτικότερα τα σταθερά εφέ σε κάθε κλιπ για τον ήχο είναι: 

 

• «Volume»: μας δίνει την δυνατότητα να αλλάξουμε την επίπεδο (level) της έντασης του 

κομματιού ήχου. 

• «Channel Volume»: μας δίνει την δυνατότητα να αλλάξουμε το επίπεδο της έντασης όταν 

υπάρχουν δύο διαφορετικά κανάλια εξαγωγής του ήχου (δεξιά και αριστερά) για κάθε ένα 

κανάλι ξεχωριστά. 
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Εικόνα 41 Παράθυρο «Effect Controls» και τα σταθερά εφέ 

5.3 Εργαλεία στο παράθυρο Effect Controls 

Στο προηγούμενο υποκεφάλαιο αναφέραμε τις λειτουργίες που έχουν τα σταθερά εφέ σε κάθε κλιπ. 

Τώρα θα περιγράψουμε τα εργαλεία που έχουμε μέσα στο παράθυρο «Effect Controls» που είναι τα 

ίδια για κάθε ένα εφέ. 

 

Εικόνα 42 Τα εργαλεία των εφέ μέσα στο παράθυρο Effect Controls 
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A. Όνομα κλιπ: μας δείχνει το όνομα του επιλεγμένου κλιπ μέσα στην ακολουθία. 

B. Όνομα ακολουθίας μαζί με το όνομα του κλιπ: μας δείχνει το όνομα της ακολουθίας 

(sequence) που βρίσκεται το επιλεγμένο κλιπ μαζί με το όνομα του. 

C. Εμφάνιση/απόκρυψη προβολής εφέ: μας επιτρέπει να εμφανίσουμε τις παραμέτρους 

που έχει κάθε εφέ ξεχωριστά ή να τις αποκρύψουμε. 

D. Κουμπί προβολής εφέ: μας επιτρέπει να απενεργοποιούμε όλο το εφέ από το κλιπ ή 

να το ενεργοποιούμε. Αυτό το κουμπί μας βοηθάει όταν θέλουμε να δούμε τις αλλαγές 

στην οθόνη προεπισκόπησης που έγιναν από την χρήση του εφέ. 

E. Toggle Animation: αυτό το κουμπί ενεργοποιεί τα «Keyframes» για κάθε ένα 

ξεχωριστό εφέ μέσα στο κλιπ. Όταν θέλουμε να έχουμε διαφορετικές τιμές του εφέ 

μέσα στο ίδιο κλιπ, πρέπει να δίνουμε τις διαφορετικές τιμές του σε κάθε χρονική 

στιγμή μέσω των «keyframes». 

F. Προσθήκη/Αφαίρεση Καρέ (keyframes) / μετακίνηση στα καρέ: όταν είναι 

ενεργοποιημένο το «Toggle Animation» τότε μας εμφανίζει αυτό το εικονίδιο που μας 

επιτρέπει να προσθέτουμε και να αφαιρούμε τα «keyframes» σε κάθε χρονική στιγμή 

και με τα βελάκια δεξιά και αριστερά να μετακινηθούμε στο επόμενο ή προηγούμενο 

καρέ (keyframe) μέσα στο κλιπ για το συγκεκριμένο εφέ. 

5.4 Παράθυρο «Effects» 

Στο προηγούμενο υποκεφάλαιο είδαμε το παράθυρο του «Effect Controls» στο οποίο μας επιτρέπει να 

βλέπουμε τα εφέ που έχουμε για κάθε ένα κλιπ ξεχωριστά και συγχρόνως να μπορούμε να τα 

επεξεργαστούμε. Όταν χρειαζόμαστε να προσθέσουμε περισσότερα εφέ στα κλιπ τότε πρέπει να 

ανοίξουμε το παράθυρο των εφέ «Effect» όπου και βρίσκονται όλα τα διαθέσιμα εφέ που μας προσφέρει 

το «Premiere Pro CC» [6]. 

Το παράθυρο των εφέ «Effect» βρίσκεται στο κάτω αριστερά παράθυρο δίπλα από την καρτέλα του 

«Project». Σε περίπτωση που δεν μας εμφανίζεται η καρτέλα για το παράθυρο «Effects» τότε 

πηγαίνουμε στο κεντρικό μενού εργαλείων πάνω αριστερά και κάνουμε κλικ στο Window > Effects. 

 

Εικόνα 43 Παράθυρο «Effects» 
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Το «Premiere Pro CC» περιλαμβάνει διάφορα εφέ ήχου και βίντεο που μπορούμε να εφαρμόσουμε σε 

κάθε κλιπ μέσα στην ακολουθία. Ένα εφέ μπορεί να προσθέσει ένα ειδικό οπτικό ή ηχητικό 

χαρακτηριστικό. Για παράδειγμα, ένα εφέ μπορεί να αλλάξει το χρώμα της εικόνας, να χειριστεί τον 

ήχο ώστε να αφαιρέσει τυχόν παράσιτα, να παραμορφώσει την εικόνα ώστε να πετύχουμε κάποιο 

καλλιτεχνικό αποτέλεσμα. Όλα αυτά τα εφέ βρίσκονται μέσα στο παράθυρο «Effects» και μπορούμε 

να τα προσθέσουμε σε κάθε ένα κλιπ. Η προσαρμογή του κάθε ενός εφέ που προσθέτουμε γίνεται μέσα 

στο παράθυρο του «Effect Controls» που αναλύσαμε στην αρχή του κεφαλαίου. 

Πολλά από τα εφέ που μας προσφέρει το «Premiere Pro CC» μπορούν να χωριστούν σε τρεις 

κατηγορίες: τα «Accelerated effects», τα «32-bit Color» και τα «YUV effects». 

 

Εικόνα 44 «Accelerated effects, 32-bit Color και τα YUV effects» 

Τα «Accelerated effects» είναι τα εφέ που μπορούν να επωφεληθούν από την επεξεργαστική ισχύ μιας 

πιστοποιημένης κάρτας γραφικών για να επιταχύνουν την απόδοση [7. Αυτή η επιτάχυνση των εφέ 

χρησιμοποιεί την τεχνολογία «CUDA» (βλ. Υποκεφάλαιο 2.2) που είναι μία τεχνολογία υψηλής 

απόδοσης στο «Premiere Pro». Σε περίπτωση που δεν διαθέτουμε μία κάρτα γραφικών που να 

υποστηρίζει την τεχνολογία «CUDA» τότε το κουμπί φίλτρου «Accelerated Effects» εξακολουθεί να 

λειτουργεί και εμφανίζεται σε απενεργοποιημένη κατάσταση για να υποδείξει ότι η επιτάχυνση δεν 

είναι διαθέσιμη. Εάν διαθέτετε μία κάρτα γραφικών που υποστηρίζει την τεχνολογία «CUDA» αλλά 

δεν την έχετε ενεργοποιημένη τότε κάνετε κλικ στην γραμμή εργαλείων πάνω αριστερά File > Project 

Settings > General και στο πεδίο «Video Rendering and Playback» επιλέγετε το «Mercury Playback 

Engine GPU Acceleration (CUDA)». 

 

Εικόνα 45 Ενεργοποίηση της τεχνολογίας «CUDA» 

Τα «32-bit Color» είναι μερικά βίντεο εφέ ή εφέ μετάβασης, που υποστηρίζουν επεξεργασία σε βάθος 

όσο αφορά τα χρώματα. Το αποτέλεσμα φέρνει πολύ καλύτερη ανάλυση χρωμάτων και η πιο ομαλή 

μετάβαση χρωμάτων από ό,τι θα ήταν δυνατό με τα προηγούμενα πρότυπα των «8-bit ανά κανάλι 

pixel». Προσοχή αν χρησιμοποιήσουμε πολλά εφέ μέσα σε ένα κλιπ και έστω ένα από όλα δεν είναι 

στα «32-bit Color» αλλά στα «8-bit Color» τότε το «Premiere Pro» θα αποδώσει όλα τα εφέ στα «8-bit 

Color». 
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Τα «YUV effects» είναι εφέ που μας προσφέρει το «Premiere Pro» με τα οποία η επεξεργασία γίνεται 

απευθείας από «YUV» τιμές χωρίς την μετατροπή σε «RGB». Το «YUV» και τα «RGB» είναι δύο 

διαφορετικές τεχνολογίες απεικόνισης των χρωμάτων της εικόνας και δεν θα τα αναλύσουμε παραπάνω. 

Με τα «YUV effects» πετυχαίνουμε αλλαγές του χρώματος της εικόνας χωρίς να έχουμε ανεπιθύμητες 

μετατροπές του χρώματος διότι δεν γίνεται η μετατροπή σε «RGB» πριν την αλλαγή των χρωμάτων 

μέσω των εφέ. 

Η λίστα των «Accelerated effects» που χρησιμοποιούν την τεχνολογία «CUDA» στο «Premiere Pro 

CC» είναι: 

• Alpha Adjust 

• Basic 3D 

• Black & White 

• Brightness & Contrast 

• Color Balance (RGB) 

• Color Pass (Windows only) 

• Color Replace 

• Crop 

• Drop Shadow 

• Edge Feather 

• Eight-Point Garbage Matte 

• Extract 

• Fast Color Corrector 

• Four-Point Garbage Matte 

• Gamma Correction 

• Garbage Matte (4, 8, 16) 

• Gaussian Blur 

• Horizontal Flip 

• Levels 

• Luma Corrector 

• Luma Curve 

• Noise 

• Proc Amp 

• RGB Curves 

• RGB Color Corrector 

• Sharpen 

• Sixteen-Point Garbage Matte 

• Three-way Color Corrector 

• Timecode 

• Tint 

• Track Matte Key 

• Ultra Keyer 

• Video Limiter 

• Vertical Flip 

• Directional Blur 
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• Fast Blur 

• Invert 

• Additive Dissolve 

• Film Dissolve 

• Warp Stabilizer 

Η λίστα των «32-bit Color effects» στο «Premiere Pro CC» είναι: 

• Cross Dissolve 

• Dip to Black 

• Dip to White 

• Film Dissolve 

• Band Wipe 

• Barn Doors 

• Checker Wipe 

• CheckerBoard 

• Clock Wipe 

• Gradient Wipe 

• Inset 

• Pinwheel 

• Radial Wipe 

• Random Blocks 

• Random Wipe 

• Spiral Boxes 

• Venetian Blinds 

• Wedge Wipe 

• Zig-Zag Blocks 

Η λίστα των «32-bit Color effects» στο «Premiere Pro CC» είναι: 

• ProcAmp 

• Gaussian Blur 

• Lumetri Color 

• Video Limiter 

• Black & White 

• Alpha Adjust 

• Luma Key 

• Track Matte Key 

• Fast Color Corrector 

• Luma Corrector 

• Luma Curve 

• RGB Color Corrector 

• RGB Curves 

• Three-Way Color Corrector 

• Video Limiter (Legacy) 
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• Crop 

• Edge Feather 

• Horizontal Flip 

• Clip Name 

• Simple Text 

• Timecode 

• Cross Dissolve 

• Dip to Black 

• Dip to White 

• Film Dissolve 

• Iris Box 

• Iris Cross 

• Iris Diamond 

• Iris Round 

• Band Slide 

• Band Wipe 

• Barn Doors 

• Checker Wipe 

• CheckerBoard 

• Clock Wipe 

• Gradient Wipe 

5.5 Παραδείγματα Εφέ 

Στο παράθυρο των «Effects» μπορούμε να βρούμε τουλάχιστον έξι φακέλους (βλ. Εικόνα 43). Ο πρώτος 

φάκελος είναι το «Presets» στον οποίο μας εμφανίζονται τα εφέ που προσθέσαμε μόνοι μας ως «plug-

in» στο «Premiere Pro CC» από άλλους δημιουργούς εφέ. Ο δεύτερος φάκελος είναι το «Lumetri 

Presets» στον οποίο βρίσκονται εφέ επεξεργασίας και αλλαγής των χρωμάτων της εικόνας του κλιπ. Ο 

τρίτος φάκελος είναι το «Audio Effects» στον οποίο βρίσκονται όλα τα εφέ που χρησιμοποιούνται για 

την επεξεργασία των κλιπ ήχου μέσα σε μία ακολουθία. Ο τέταρτος φάκελος είναι το «Audio 

Transitions» στον οποίο βρίσκονται όλα τα εφέ που μπορούμε να εφαρμόσουμε για να πετύχουμε 

μεταβάσεις ήχου μεταξύ δύο κλιπ ήχου στο ίδιο κανάλι. Συγκεκριμένα στο «Premiere Pro CC» 

υπάρχουν μόλις τρεις μεταβάσεις ήχου που είναι τύπου εξασθένησης ήχου (Crossfade) και είναι οι εξής: 

«Constant Gain, Constant Power και Exponential Fade». Ο πέμπτος φάκελος είναι το «Video Effects» 

στον οποίο βρίσκουμε όλα τα εφέ που μπορούμε να εφαρμόσουμε σε κλιπ βίντεο και να προσθέσουν 

κάποιο ειδικό οπτικό χαρακτηριστικό. Ο έκτος φάκελος είναι το «Video Transitions» στον οποίο 

βρίσκονται όλα τα εφέ που μπορούμε να εφαρμόσουμε για να πετύχουμε μεταβάσεις εικόνας μεταξύ 

δύο κλιπ στο ίδιο κανάλι. 

Αυτοί είναι οι έξι βασικοί φάκελοι που βρίσκουμε στο παράθυρο των εφέ (Effects). Επίσης έχουμε την 

επιλογή να δημιουργήσουμε δικούς μας φακέλους πατώντας κάτω δεξιά στο παράθυρο των εφέ κλικ 

στο εργαλείο «New Custom Bin» και εάν θέλουμε να διαγράψουμε έναν φάκελο που έχουμε 

δημιουργήσει εμείς μέσα στο παράθυρο των εφέ τότε στο παράθυρο των εφέ κάτω δεξιά κάνουμε κλικ 

στο εργαλείο «Delete Custom Items». Όταν δημιουργούμε δικούς μας φακέλους μπορούμε να 

κρατήσουμε και να σύρουμε μέσα σε αυτούς όλα τα διαθέσιμα εφέ που μας προσφέρει το «Premiere 

Pro CC» έτσι ώστε να ομαδοποιήσουμε όπως εμείς θέλουμε τα εφέ. 
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Εικόνα 46 Δημιουργία και διαγραφή Custom Bin στο παράθυρο των Effects 

Ας δούμε μερικά παραδείγματα εφέ και να αναλύσουμε την χρήση τους μέσα σε μια ακολουθία: 

Στον φάκελο «Video Transitions» θα βρούμε όλα τα εφέ που επηρεάζουν την μετάβαση ενός κλιπ σε 

ένα άλλο κλιπ. Αυτά τα εφέ μπορούμε να τα σύρουμε ανάμεσα σε δύο κλιπ, στο τέλος ενός κλιπ ή στην 

αρχή ενός κλιπ.  

Επίσης αν πατήσουμε αριστερό κλικ πάνω στο τοποθετημένο εφέ μέσα στην ακολουθία, μας εμφανίζει 

στο παράθυρο του «Effect Controls» τις παραμέτρους που μπορούμε να αλλάξουμε για το εφέ 

μετάβασης βίντεο. Οι δύο παράμετροι που μπορούμε να αλλάξουμε είναι η διάρκεια (Duration) και η 

στοίχιση του εφέ (Alignment). Με την διάρκεια (Duration) ρυθμίζουμε πόση ώρα θα χρησιμοποιείται 

το εφέ στα κλιπ και με την στοίχιση (Alignment) επιλέγουμε αν το εφέ θέλουμε να εφαρμόζεται είτε 

ακριβώς ανάμεσα στα δύο κλιπ (Center at Cut), είτε στην αρχή του δεύτερου κλιπ (Start at Cut), είτε 

στο τέλος του πρώτου κλιπ (End at Cut).  

Ένας γρήγορος τρόπος για να προσθέτουμε ένα προεπιλεγμένο «Video Transition» είναι πατώντας δεξί 

κλικ ανάμεσα σε δύο κλιπ και επιλέγοντας το «Apply Default Transitions». Για να ορίσουμε ένα εφέ 

ως προεπιλεγμένο πηγαίνουμε στο παράθυρο των «Effects», στον φάκελο «Video Transitions» και 

κάνοντας δεξί κλικ στο εφέ που θέλουμε, επιλέγουμε το «Set Selected as Default Transition». 

Με τον ίδιο τρόπο γίνεται και η εφαρμογή των εφέ μετάβασης ήχου (Audio Transitions). Στις εικόνες 

που ακολουθούν χρησιμοποιήσαμε το εφέ μετάβασης βίντεο «Film Dissolve». 
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Εικόνα 47 Τοποθέτηση ενός «Video Transition» ανάμεσα σε δύο κλιπ 

 

Εικόνα 48 Η εμφάνιση του εφέ «Film Dissolve» ανάμεσα σε δύο κλιπ 
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Εικόνα 49 Παράθυρο «Effect Controls» για το «Film Dissolve» 

 

Εικόνα 50 Δεξί κλικ ανάμεσα σε δύο κλιπ και η επιλογή «Apply Default Transitions» 

Στον φάκελο «Video Effects» βρίσκουμε όλα τα εφέ που εφαρμόζονται στα κλιπ βίντεο και που μας 

βοηθάνε στην επεξεργασία ή στην προσθήκη καλλιτεχνικών εφέ μέσα στην εικόνα του βίντεο.  

Ως παράδειγμα θα αναλύσουμε το εφέ «Crop» που βρίσκεται μέσα στον υποφάκελο «Transform». 
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Εικόνα 51 «Crop Effect» 

 

Το εφέ του «Crop» μας επιτρέπει να κόψουμε την εικόνα από το κλιπ που θα εφαρμόσουμε το εφέ από 

τις τέσσερις μεριές του. Δηλαδή από αριστερά, πάνω, δεξιά και κάτω. 

 

 

Εικόνα 52 Οι παράμετροι του «Crop» μέσα στο παράθυρο «Effect Controls» 

 

Στην παρακάτω εικόνα έχουμε χρησιμοποιήσει το «Crop» εφέ και έχουμε ορίσει να κόψει από την πάνω 

μεριά (Top) το είκοσι τις εκατό (20%) και από την κάτω μεριά (Button) το είκοσι τις εκατό (20%). Έτσι 

στο παράθυρο προεπισκόπησης της ακολουθίας η εικόνα του συγκεκριμένου κλιπ εμφανίζεται κομμένη 

από πάνω και από κάτω. 

 

 

Εικόνα 53 Χρήση του εφέ Crop από την πάνω και την κάτω μεριά κατά είκοσι τις εκατό 

5.6 Adjustment Layer 

Οι παράμετροι που μπορούμε να επεξεργαστούμε για το κάθε εφέ θα βρίσκονται πάντα μέσα στο 

παράθυρο των «Effect Controls». 
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Όπως αναφέραμε το κάθε εφέ εφαρμόζεται σε κάθε κλιπ ξεχωριστά. Εάν θέλουμε να εφαρμόσουμε το 

ίδιο εφέ σε ένα σύνολο από πολλά κλιπ μέσα στην ακολουθία τότε χρησιμοποιούμε ένα βοηθητικό 

στοιχείο το «Adjustment Layer» [8]. 

Για να δημιουργήσουμε ένα «Adjustment Layer» πηγαίνουμε στο παράθυρο του «Project» και πατάμε 

New Item > Adjustment Layer. Στην συνέχεια επιλέγουμε τις διαστάσεις που θέλουμε να 

δημιουργηθεί το νέο στοιχείο «Adjustment Layer».Το «Adjustment Layer» δημιουργείται μέσα στο 

παράθυρο του «Project» και μπορούμε να το χειριστούμε ακριβώς όπως ένα κλιπ βίντεο.  

Το «Adjustment Layer» είναι επίπεδο προσαρμογής το οποίο τοποθετείτε σε ένα κανάλι βίντεο μέσα 

στην ακολουθία και επηρεάζει τα κλιπ που είναι στα κάτω κανάλια.  

Για παράδειγμα, εάν έχουμε δύο κλιπ στο κανάλι «V1» και τοποθετήσουμε ένα «Adjustment Layer» 

στο κανάλι «V2» το οποίο διαρκεί από την αρχή του πρώτου κλιπ έως το τέλος του δεύτερου κλιπ και 

στην συνέχεια τοποθετήσουμε ένα εφέ βίντεο στο «Adjustment Layer» η εφαρμογή αυτού του εφέ θα 

γίνει στα δύο κλιπ που είναι στο χαμηλότερο κανάλι, δηλαδή στο κανάλι «V1». 

 

 

Εικόνα 54 Δημιουργία και εμφάνιση ενός «Adjustment Layer» μέσα στο παράθυρο «Project» 



Παράθυρο των «Effect Controls» και «Effects» 

39 

 

Εικόνα 55 Τοποθέτηση ενός «Adjustment Layer» μέσα σε μία ακολουθία και πάνω από τα κλιπ βίντεο 

5.7 Επίλογος 

Σε αυτό το κεφάλαιο αναφερθήκαμε σε δύο νέα παράθυρα του προγράμματος του «Premiere Pro CC», 

το παράθυρο των «Effect Controls» και το παράθυρο των «Effects». Επιπλέον είδαμε και την χρήση 

του στοιχείου «Adjustment Layer». Στο επόμενο κεφάλαιο θα δούμε πώς επεξεργαζόμαστε τα χρώματα 

της εικόνας μέσα στην ακολουθία μας, ώστε να διορθώσουμε τους χρωματισμούς είτε να δώσουμε την 

δική μας καλλιτεχνική όψη στο τελικό βίντεο. 
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Κεφάλαιο 6ο: Χρωματισμός - Coloring 

6.1 Εισαγωγή 

To «Premiere Pro CC» μας παρέχει εργαλεία τα οποία μας επιτρέπει να διορθώσουμε τα χρώματα σε 

επαγγελματική ποιότητα στα κλιπ που έχουμε μέσα σε μία ακολουθία. 

Αυτά τα εργαλεία είναι διαθέσιμα σε έναν χώρο εργασίας που ονομάζεται «Lumetri Color». 

Χρησιμοποιώντας αυτά τα εργαλεία που μας προσφέρει το «Lumetri Color» μπορούμε να 

προσαρμόσουμε το χρώμα, την αντίθεση και το φως των πλάνων που έχουμε μέσα σε μια ακολουθία 

με νέους και καινοτόμους τρόπους. 

Ο χώρος εργασίας για τον χρωματισμό έχει σχεδιαστεί έτσι ώστε να είναι πολύ φιλικό και εύχρηστο και 

για έμπειρους χρήστες του «Premiere Pro CC» καθώς και για νέους χρήστες. 

6.2 Χώρος Εργασίας για τον Χρωματισμό - Coloring 

Το «Premiere Pro» έχει έναν προκαθορισμένο χώρο εργασίας για τον χρωματισμό και αυτό καθιστά την 

εργασία για την επεξεργασία των χρωμάτων γρηγορότερη και αποτελεσματικότερη. 

Για να μεταβούμε στον χώρο εργασίας για τον χρωματισμό επιλέγουμε από την γραμμή εργαλείων στο 

κεντρικό μενού πάνω αριστερά Window > Workspaces > Color ή εναλλακτικά μπορούμε να 

χρησιμοποιήσουμε μέσα στο περιβάλλον εργασίας του «Premiere Pro CC» την εναλλαγή του χώρου 

εργασίας από το «Editing» στο «Color». 

 

Εικόνα 56 Επιλογή χώρου εργασίας από το μενού εργαλείων 
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Εικόνα 57 Επιλογή χώρου εργασίας από το περιβάλλον εργασίας του «Premiere Pro CC» 

 

Εικόνα 58 Χώρος εργασίας για τον χρωματισμό των κλιπ στο περιβάλλον του «Premiere Pro CC» 

Ο πίνακας «Lumetri Color» που φαίνεται στο δεξί μέρος της «Εικόνας 58» προσφέρει ισχυρά και 

εύχρηστα εργαλεία, όπως καμπύλες χρώματος, τροχούς αλλαγής τονικότητας και χρώματος και γενικές 

ρυθμίσεις τιμών στις αλλαγές των χρωμάτων. Κάθε τμήμα του «Lumetri Color» επικεντρώνεται σε μια 

συγκεκριμένη ενέργεια για την αλλαγή του χρώματος. 

Ο πίνακας «Lumetri Scopes» που φαίνεται στο αριστερό πάνω μέρος της «Εικόνας 58» εμφανίζει 

διαφορετικές αναλύσεις και κυματομορφές με βάση τα χρώματα (κόκκινο, μοβ, μπλε, κυανό, πράσινο 

και κίτρινο) και την φωτεινότητα στο κλιπ που έχουμε επιλέξει. Με δεξί κλικ μέσα στο παράθυρο 

μπορούμε να επιλέξουμε και άλλες κυματομορφές και πίνακες που μας βοηθάνε στην κατανόηση και 

ανάλυση των χρωμάτων της εικόνας. 

6.3 Διόρθωση Χρώματος – Color Correction  

Η διόρθωση χρώματος «Color Correction» είναι η τεχνική που χρησιμοποιούμε για να προσαρμόσουμε 

τα χρώματα της εικόνας από το κλιπ σε πραγματικές-ρεαλιστικές καταστάσεις [9]. 

Για την διόρθωση του χρώματος χρησιμοποιούμε από τον πίνακα «Lumetri Color» την ενότητα «Basic 

Correction» και ακολουθούμε τα εξής βήματα: 

1. Τοποθετούμε την κεφαλή αναπαραγωγής στο απαιτούμενο κλιπ της ακολουθίας προς 

επεξεργασία των χρωμάτων. Όταν ο πίνακας «Lumetri Color» είναι ανοιχτός τότε το 

«Premiere Pro CC» επιλέγει αυτόματα το κλιπ που βρίσκεται στην κεφαλή αναπαραγωγής 

οπότε και διασφαλίζει ότι όλες οι αλλαγές χρώματος θα εφαρμόζονται στο επιλεγμένο κλιπ. 
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2. Ξεκινάμε να κάνουμε τις προσαρμογές των χρωμάτων χρησιμοποιώντας την βασική 

διόρθωση (Basic Correction). 

Οι επιλογές  στην ενότητα «Basic Correction» μας βοηθάνε να διορθώσουμε το βίντεο που είναι πολύ 

σκοτεινό ή πολύ φωτεινό και να προσαρμόσουμε την απόχρωση όσο και τη φωτεινότητα (έκθεση και 

αντίθεση) στο κλιπ μας. 

Για την ρύθμιση απλά κρατάμε το αριστερό κλικ και μετακινούμε την μπάρα αριστερά ή δεξιά ανάλογα 

με το αποτέλεσμα που θέλουμε να πετύχουμε. 

Η πρώτη επιλογή είναι η εισαγωγή ενός «LUT» (Look Up Table) ως σημείο εκκίνησης για την 

επιλογή των αποχρώσεων των χρωμάτων στο κλιπ και στη συνέχεια χρησιμοποιούμε τις άλλες επιλογές 

ελέγχου χρώματος για περαιτέρω επεξεργασία. Το «Premiere Pro CC» μας παρέχει πολλά 

προκαθορισμένα «LUT» που μπορούμε να εφαρμόσουμε στα κλιπ μας ή και να χρησιμοποιήσουμε δικά 

μας προσαρμοσμένα «LUT» που έχουμε αποθηκεύσει.  

 

Εικόνα 59 Επιλογή του LUT (Look Up Table) μέσα στην ενότητα «Basic Correction» 

Η δεύτερη επιλογή είναι η ισορροπία του λευκού χρώματος «White Balance» που αντικατοπτρίζει 

τις συνθήκες φωτισμού κάτω από τις οποίες τραβήχτηκε το βίντεο. Η προσαρμογή της ισορροπίας 

λευκού μπορεί να βελτιώσει αποτελεσματικά το χρώμα του περιβάλλοντος στο κλιπ μας. 

Η προσαρμογή της ισορροπίας λευκού γίνεται αλλάζοντας τις ιδιότητες θερμοκρασίας και απόχρωσης 

(Temperature και Tint). Επίσης μπορούμε να χρησιμοποιήσουμε το εργαλείο σταγονόμετρο για να 

κάνουμε κλικ μέσα σε μια περιοχή στο πλάνο που είναι λευκή ή περισσότερο ουδέτερη ως χρώμα και 

το πρόγραμμα θα προσαρμόσει αυτόματα την ισορροπία λευκού στην θερμοκρασία και στην απόχρωση.  

Η θερμοκρασία (Temperature) ρυθμίζει με ακρίβεια την ισορροπία λευκού χρησιμοποιώντας μια 

κλίμακα θερμοκρασίας χρώματος. Μετακινώντας αριστερά την μπάρα ρύθμισης το βίντεο θα φαίνεται 

πιο “δροσερό” ενώ μετακινώντας προς τα δεξιά το βίντεο θα έχει πιο “ζεστά” χρώματα. 

Η απόχρωση (Τint) ρυθμίζει με ακρίβεια την ισορροπία λευκού για να αντισταθμίσει μια πράσινη ή 

κόκκινη απόχρωση. Για να προσθέσουμε μεγαλύτερη πράσινη απόχρωση μετακινούμε αριστερά την 

μπάρα ρύθμισης, ενώ για να προσθέσουμε μία πιο κόκκινη-μοβ απόχρωση μετακινούμε προς τα δεξιά 

την μπάρα ρύθμισης. 



Χρωματισμός - Coloring 

43 

 

Εικόνα 60 Επιλογή του «White Balance» 

Η τρίτη επιλογή είναι ο τόνος «Tone» που προσαρμόζει την τονική κλίμακα από το κλιπ μας 

χρησιμοποιώντας διαφορετικές επιλογές για τον τόνο. 

Η Έκθεση «Exposure» ρυθμίζει την φωτεινότητα του κλιπ. Μετακινούμε την μπάρα ρύθμισης προς 

τα δεξιά για να αυξήσουμε τις τονικές τιμές και να επεκτείνουμε τα φωτεινά σημεία. Μετακινούμε την 

μπάρα ρύθμισης προς τα αριστερά για να μειώσουμε τις τονικές τιμές και να επεκτείνουμε τις σκιές. 

Η Αντίθεση «Contrast» αυξάνει ή μειώνει την αντίθεση. Η προσαρμογή της αντίθεσης επηρεάζει 

κυρίως τους μεσαίους χρωματικούς τόνους στο κλιπ. Όταν μετακινούμε την μπάρα ρύθμισης προς τα 

δεξιά τότε αυξάνουμε τις μεσαίες μαζί με τις σκοτεινές περιοχές και γίνονται πιο σκούρες. Αντίστοιχα 

όταν μετακινούμε την μπάρα ρύθμισης προς τα αριστερά τότε οι μεσαίες μαζί με τις φωτεινές περιοχές 

γίνονται πιο “ανοιχτές-φωτεινές”. 

Οι Φωτεινές στιγμές «Highlights» ρυθμίζει τις φωτεινές περιοχές. Η προσαρμογή στις φωτεινές 

περιοχές της εικόνας του κλιπ γίνεται μετακινώντας την μπάρα ρύθμισης προς τα αριστερά για να 

δώσουμε έναν πιο σκούρο τόνο στις φωτεινές περιοχές και αντίστοιχα μετακινώντας την μπάρα 

ρύθμισης προς τα δεξιά φωτίζουμε τις φωτεινές περιοχές της εικόνας του κλιπ. 

Οι Σκιές «Shadows» προσαρμόζει τις σκοτεινές περιοχές. Η προσαρμογή για τις σκοτεινές περιοχές 

της εικόνας του κλιπ γίνεται μετακινώντας την μπάρα ρύθμισης προς τα αριστερά για να αλλάξει ο 

τόνος των σκιών και να γίνουν πιο σκούρες. Αντίστοιχα μετακινώντας την μπάρα ρύθμισης προς τα 

δεξιά φωτίζουμε τις σκιές με αποτέλεσμα να βλέπουμε μεγαλύτερη λεπτομέρεια στις σκιές της εικόνας 

του κλιπ. 

Τα Λευκά «Whites» ρυθμίζουν τις άσπρες περιοχές στο κλιπ. Μετακινώντας την μπάρα ρύθμισης προς 

τα αριστερά μειώνουμε τις λευκές αποχρώσεις της εικόνας του κλιπ και αντίστοιχα μετακινώντας την 

μπάρα ρύθμισης προς τα δεξιά αυξάνουμε τις λευκές αποχρώσεις. 

Τα Μαύρα «Blacks» ρυθμίζει τις μαύρες/σκούρες περιοχές στο κλιπ. Μετακινώντας την μπάρα 

ρύθμισης προς τα αριστερά αυξάνουμε την ένταση του τόνου του μαύρου, έτσι πετυχαίνουμε ακόμη 

πιο μαύρες σκιές στην εικόνα του κλιπ. Αντίστοιχα μετακινώντας την μπάρα ρύθμισης προς τα δεξιά 

μειώνουμε την ένταση του μαύρου τόνου στην εικόνα του κλιπ. 

Η Επαναφορά «Reset» επαναφέρει όλα τα στοιχεία ελέγχου του τόνου στις αρχικές ρυθμίσεις. 

Το Αυτόματα «Auto» αυτόματα το «Premiere Pro CC» ρυθμίζει την συνολική τονική κλίματα. 

Ο κορεσμός «Saturation» προσαρμόζει εξίσου τον κορεσμό όλων των χρωμάτων στην εικόνα του 

κλιπ. Μετακινώντας την μπάρα ρύθμισης προς τα αριστερά μειώνουμε τον συνολικό κορεσμό των 

χρωμάτων. Αντίστοιχα μετακινώντας την μπάρα ρύθμισης προς τα δεξιά αυξάνουμε τον συνολικό 

κορεσμό των χρωμάτων. 
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Εικόνα 61 Επιλογές στην καρτέλα του «Tone» μέσα στην λίστα του «Basic Correction» 

6.4 Δημιουργικός Χρωματισμός – Color Grading 

Ο Δημιουργικός Χρωματισμός «Color Grading» είναι η τεχνική που χρησιμοποιούμε για να 

αλλάξουμε την εμφάνιση των χρωμάτων μέσα στην εικόνα του βίντεο. Ο Δημιουργικός Χρωματισμός 

έπεται της διαδικασίας της Διόρθωσης Χρωμάτων. Συνήθως όταν ολοκληρώσουμε την διόρθωση 

χρωμάτων σε κάθε ένα κλιπ ξεχωριστά, τοποθετούμε ένα νέο «Adjustment Layer» στο οποίο 

εφαρμόζουμε την τεχνική του Δημιουργικού Χρωματισμού (Color Grading) γιατί θέλουμε να 

πετύχουμε την ίδια καλλιτεχνική εμφάνιση των χρωμάτων σε όλη την διάρκεια του βίντεο. 

Η πρώτη ενότητα για το «Color Grading» είναι το «Creative» η οποία περιλαμβάνει διάφορες 

εμφανίσεις που μας επιτρέπει να κάνουμε γρήγορες προσαρμογές χρώματος στα κλιπ [10]. 

Οι εμφανίσεις αυτές ονομάζονται «Look» και το «Premiere Pro CC» περιλαμβάνει ήδη υπάρχουσες 

προεπιλογές. Επίσης μπορούμε να δημιουργήσουμε δικά μας προσαρμοσμένα «LUT» και να τα 

αποθηκεύσουμε ώστε να εμφανίζονται στην λίστα των «Look» και να τα χρησιμοποιούμε. 

Στην συνέχεια μπορούμε να χρησιμοποιήσουμε την επιλογή  Έντασης «Intensity» για να 

προσαρμόσουμε την ένταση της εφαρμοζόμενης εμφάνισης. Μετακινώντας την μπάρα ρύθμισης προς 

τα δεξιά αυξάνουμε το εφέ της εφαρμοζόμενης εμφάνισης. Αντίστοιχα μετακινώντας την μπάρα προς 

τα αριστερά μειώνουμε την ένταση του εφέ εμφάνισης. 

Στην συνέχεια έχουμε την καρτέλα Προσαρμογές «Adjustments». Αναλυτικά αυτή η καρτέλα μας 

προσφέρει τις επιλογές: 
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• Ξεθωριασμένη Ταινία «Faded Film»: Με αυτή την επιλογή μπορούμε να εφαρμόσουμε ένα 

ξεθωριασμένο φιλμ στο βίντεο μας. Μετακινώντας την μπάρα ρύθμισης προς τα δεξιά ή προς 

τα αριστερά μπορούμε να πετύχουμε μία επιθυμητή «Vintage» εμφάνιση. 

• Ευκρίνειας «Sharpen»: Με αυτή την επιλογή μπορούμε να πετύχουμε μεγαλύτερη ευκρίνεια 

στην εμφάνιση του βίντεο. Μετακινώντας την μπάρα ρύθμισης προς τα δεξιά αυξάνουμε τον 

βαθμό της ευκρίνειας στην εικόνα. Αντίστοιχα μετακινώντας την μπάρα ρύθμισης προς τα 

αριστερά μειώνουμε το βαθμό ακρίβειας. Προσοχή, αν αυξήσουμε πολύ την ευκρίνεια στις 

λεπτομέρειες της εικόνας στο βίντεο μπορεί το αποτέλεσμα να φαίνεται αφύσικο. 

• Δόνησης «Vibrance»: Με αυτή την επιλογή προσαρμόζουμε τον κορεσμό ώστε να 

προσαρμόσουμε τα χρώματα να μην φτάσουν σε αυξημένα επίπεδα κορεσμού στο βίντεο. Αυτή 

η ρύθμιση επηρεάζει περισσότερο τον κορεσμό στους χαμηλότερους τόνους και λιγότερο τον 

κορεσμό εντονότερων τόνων. 

• Κορεσμός «Saturation»: Με αυτή την επιλογή ρυθμίζουμε τον κορεσμό όλων των χρωμάτων 

στο κλιπ εξίσου. Η τιμή “0” μας δίνει ένα ασπρόμαυρο αποτέλεσμα (άχρωμο) και φτάνει έως 

την τιμή “200” που αποδίδει διπλή ένταση κορεσμού χρωμάτων. 

• Τροχοί Αποχρώσεων «Tint Wheels»: Έχουμε δύο τροχούς, τον «Shadow Tint» και τον 

«Highlight Tint». Σε αυτούς τους τροχούς μπορούμε να ρυθμίσουμε τις τιμές των αποχρώσεων 

στις σκιές «Shadow Tint» και στα φωτεινά σημεία «Highlight Tint». Για να εφαρμόσουμε 

αλλαγές κάνουμε κλικ στη μέση του τροχού και μετακινούμε τον κέρσορα στα χρώματα που 

θέλουμε. 

• Εξισορρόπηση Απόχρωσης «Tint Balance»: Εξισορροπεί τις αποχρώσεις του μοβ και τις 

αποχρώσεις του πράσινου. 

 

Εικόνα 62 Επιλογές στην λίστα του «Creative» 
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Η δεύτερη ενότητα για το «Color Grading» είναι οι Καμπύλες «Curves». Η ενότητα «Curves» του 

«Premiere Pro CC» μας επιτρέπει να κάνουμε γρήγορες και ακριβείς προσαρμογές χρώματος και να 

επιτύχουμε φυσικά αποτελέσματα. Έχουμε δύο τύπους καμπυλών «Curves» που μπορούμε να 

επεξεργαστούμε τα χρώματα[11]. 

Ο πρώτος τύπος καμπύλης είναι το «RGB Curves» που μπορούμε να επεξεργαστούμε το εύρος της 

φωτεινότητας και το εύρος του τόνου σε όλο το κλιπ χρησιμοποιώντας καμπύλες. Η κύρια καμπύλη 

ελέγχει την φωτεινότητα. Η κύρια καμπύλη παριστάνεται ως ευθεία λευκή διαγώνια γραμμή. Η 

προσαρμογή της κύριας καμπύλης προσαρμόζει τις τιμές και των τριών καναλιών «RGB» ταυτόχρονα. 

Μπορούμε να επιλέξουμε τα τρία χρώματα (κόκκινο, πράσινο, μπλε) να τα επεξεργαστούμε ξεχωριστά, 

πατώντας στον αντίστοιχο χρωματισμένο κύκλο της καρτέλας «RGB Curves». Επίσης από το κέντρο 

της ευθείας γραμμής και προς τα πάνω δεξιά αναπαριστά τα φωτεινά σημεία. Ενώ από το κέντρο της 

ευθείας και προς τα κάτω αριστερά αναπαριστά τις σκιές. 

 

Εικόνα 63 «RGB Curves» 

Ο δεύτερος τύπος καμπύλης είναι οι Καμπύλες Κορεσμού Αποχρώσεων «Hue Saturation Curves» 

τις οποίες τις χρησιμοποιούμε για να κάνουμε διαφορετικούς τύπους προσαρμογών χρώματος με βάση 

καμπύλες στο κλιπ μας. Έχουμε πέντε διαφορετικές επιλογές οι οποίες είναι: 

• Απόχρωση έναντι Κορεσμού «Hue vs Sat»: Μπορούμε να επιλέξουμε ένα εύρος αποχρώσεων 

και να το ρυθμίσουμε στο επίπεδο κορεσμού που επιθυμούμε. 

 

Εικόνα 64 «Hue vs Sat» 
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• Απόχρωση έναντι Απόχρωσης «Hue vs Hue»: Μπορούμε να επιλέξουμε ένα εύρος 

απόχρωσης και να το αλλάξουμε σε μια άλλη απόχρωση. 

 

Εικόνα 65 «Hue vs Hue» 

• Απόχρωση έναντι Φωτεινότητας «Hue vs Luma»: Μπορούμε να επιλέξουμε μία απόχρωση 

και να ρυθμίσουμε την φωτεινότητα της. 

 

Εικόνα 66 «Hue vs Luma» 

• Φωτεινότητα έναντι κορεσμού «Luma vs Sat»: Επιλέγουμε ένα εύρος φωτεινότητας και 

μπορούμε να ρυθμίσουμε τον κορεσμό του. 
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Εικόνα 67 «Luma vs Sat» 

• Κορεσμός έναντι κορεσμού «Sat vs Sat»: Επιλέγουμε ένα εύρος κορεσμού και μπορούμε να 

αυξήσουμε ή να μειώσουμε τον κορεσμό του. 

 

Εικόνα 68 «Sat vs Sat» 

Υπάρχουν δύο τρόποι για να επιλέξουμε τις τιμές στις Καμπύλες Κορεσμού Αποχρώσεων.  

Ο πρώτος και πιο συνηθισμένος είναι να πάμε στο εργαλείο δειγματοληψίας πάνω δεξιά σε κάθε 

καμπύλη και να επιλέξουμε μέσα από την εικόνα την απόχρωση που θέλουμε να επεξεργαστούμε σε 

κάθε μία καμπύλη. 

Ο δεύτερος τρόπος είναι πηγαίνοντας τον κέρσορα πάνω σε κάθε γραμμή, εμφανίζεται το εργαλείο 

Πένας «Pen Tool», και μπορούμε να ορίσουμε σημεία ελέγχου στις αποχρώσεις που μας προσφέρει η 

γραμμή. 

Στην συνέχεια όταν έχουμε επιλέξει τις αποχρώσεις που θέλουμε πηγαίνοντας στα σημεία ελέγχου που 

εμφανίστηκαν πάνω στις γραμμές μπορούμε να τις μετακινήσουμε πάνω ή κάτω και να επεξεργαστούμε 

ανάλογα με το αποτέλεσμα που θέλουμε να πετύχουμε. 

Η τρίτη ενότητα για το «Color Grading» είναι οι Τροχοί Χρώματος «Color Wheels & Match» [12]. 

Οι έγχρωμοι τροχοί μας επιτρέπουν να κάνουμε προσαρμογές του χρώματος μόνο στις σκοτεινές ή 

φωτεινές περιοχές της εικόνας του κλιπ. Ο επιπλέον αυτός έλεγχος μας βοηθάει να διορθώσουμε 

λεπτομέρειες στην εικόνα και να προσθέσουμε μία απόχρωση στην τελική εμφάνιση που δημιουργούμε. 
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Το «Premiere Pro CC» μας προσφέρει τρεις έγχρωμους τροχούς που μπορούμε να τους επεξεργαστούμε 

ανεξάρτητα την φωτεινότητα, την απόχρωση και τον κορεσμό για: 

• Μεσαίων Τόνων «Midtones» 

• Σκιών «Shadows» 

• Φωτεινών σημείων «Highlights» 

 

Εικόνα 69 «Color Wheels & Match» 

Η τέταρτη ενότητα για το «Color Grading» είναι το «HSL Secondary» [13]. Αυτή η ενότητα 

συνδυάζεται με τα υπάρχοντα εργαλεία για να μας δώσει έναν ακόμη καλύτερο έλεγχο στις εικόνες από 

τα κλιπ. 

Ο στόχος αυτής της ενότητας είναι να επεξεργαστούμε ένα συγκεκριμένο χρώμα και όχι την συνολική 

εικόνα από το κλιπ μας. Ο έλεγχος ενός μόνο χρώματος είναι απαραίτητος όταν οι καμπύλες κορεσμού 

της συνολικής εικόνας αγγίζουν τα όρια τους και εμείς θέλουμε να επεξεργαστούμε ένα χρώμα το οποίο 

δεν έχει φτάσει την επιθυμητή τιμή που θέλουμε να εφαρμόσουμε. 

Η ενότητα «HSL Secondary» περιέχει τρία εργαλεία: 

• Ορισμός κλειδιού «Key»: Σε αυτή την επιλογή ορίζουμε την συγκεκριμένη απόχρωση που 

θέλουμε να επεξεργαστούμε. 
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Εικόνα 70 Ορισμός κλειδιού «Key» 

• Εκκαθάριση «Refine»: Σε αυτή την ενότητα χρησιμοποιούμε δύο ρυθμίσεις. Την ρύθμιση 

«denoise» για να εξομαλύνουμε τα χρώματα και να αφαιρέσουμε τυχόν παραμορφώσεις των 

χρωμάτων. Και την ρύθμιση «blur» που την χρησιμοποιούμε για να “μαλακώσουμε” τις άκρες 

από τις μάσκες που δημιουργήθηκαν γύρω από τις επιλεγμένες αποχρώσεις. 

 

Εικόνα 71Εκκαθάριση «Refine» 

• Διόρθωση «Correction»: Σε αυτή την επιλογή εμφανίζεται ένας έγχρωμος τροχός μεσαίου 

τόνου αλλά μπορούμε να μεταβούμε και σε έναν τροχό τριών κατευθύνσεων κάνοντας κλικ στο 

εικονίδιο ακριβώς πάνω από τον τροχό. Επίσης σε αυτή την επιλογή έχουμε και τις ρυθμίσεις 

για την θερμοκρασία (Temperature), την απόχρωση (Tint), την αντίθεση (Contrast), την 

ευκρίνεια (Sharpen) και του κορεσμού (Saturation). 
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Εικόνα 72 Διόρθωση «Correction» 

Η Πέμπτη και τελευταία ενότητα για το «Color Grading» είναι το «Vignette» [14]. Σε αυτή την 

ενότητα εφαρμόζουμε τις ρυθμίσεις για να πετύχουμε μία ξεθωριασμένη εμφάνιση στις άκρες και πιο 

φωτεινή στο κέντρο. 

Ο λόγος που χρησιμοποιούμε αυτή την ενότητα είναι για να πετύχουμε μία εμφάνιση που θέλουμε να 

κατευθύνουμε τα βλέμματα των θεατών σε ένα συγκεκριμένο θέμα στο κάδρο της εικόνας όπως είναι 

ένα πρόσωπο ή ένα συγκεκριμένο αντικείμενο. 

Οι ρυθμίσεις που μας προσφέρει αυτή η ενότητα μας επιτρέπουν να ελέγχουμε το μέγεθος, το σχήμα 

και την ποσότητα του φωτισμού στις άκρες από το κάδρο μας. Αυτές οι ρυθμίσεις είναι: 

• Ποσότητα «Amount»: Ρυθμίζει την ποσότητα του φωτισμού ή του σκούρου χρώματος στις 

άκρες της εικόνας μας. Μετακινώντας την μπάρα ρύθμισης αλλάζει και η σκίαση της εικόνας. 

• Μεσαίες τιμές «Midpoint»: Σε αυτή την ρύθμιση επιλέγουμε το πλάτος της περιοχής της 

εικόνας που θα επηρεάζεται από την ρύθμιση «Amount». Μετακινώντας την μπάρα ρύθμισης 

επηρεάζουμε και την περιοχή που θα εφαρμόζεται η ρύθμιση «Amount». 

• Στρογγυλότητα «Roundness»: Σε αυτή την ρύθμιση επιλέγουμε την στρογγυλότητα που θα 

εφαρμοστεί στην μέση από την εικόνα μας. Μετακινώντας την μπάρα ρύθμισης επηρεάζουμε 

το πόσο έντονο θα είναι το φαινόμενο να στρογγυλεύει η εφαρμογή της ενότητας στο κέντρο 

της εικόνας. 

• Φτερό «Feather»: Με αυτή την ρύθμιση επιλέγουμε την λεπτομέρεια-ευκρίνεια που θα έχουν 

οι άκρες της εικόνας στο κλιπ. 
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Εικόνα 73 Ενότητα «Vignette» 

6.5 Επίλογος 

Σε αυτό το κεφάλαιο αναφέραμε τις δύο διαφορετικές χρήσεις για τον χρωματισμό. Ο πρώτος που είναι 

η διόρθωση χρωματισμού τον χρησιμοποιούμε έτσι ώστε το χρώμα και η τονικότητα της εικόνας μας 

να είναι σε ρεαλιστικές τιμές. Η δεύτερη χρήση του δημιουργικού χρωματισμού μας επιτρέπει να 

δώσουμε στην εικόνα την όψη στα χρώματα και την τονικότητα για να προσδώσουμε στην εικόνα την 

προσωπική καλλιτεχνική άποψη. Στο επόμενο κεφάλαιο θα δούμε τους τρόπους με τους οποίους 

μπορούμε να επιτυγχάνουμε την επεξεργασία της εικόνας για να έχουμε μία ομαλή αναπαραγωγή 

προεπισκόπησης. 
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Κεφάλαιο 7ο: Βελτιστοποίηση της Προεπισκόπησης 

7.1 Εισαγωγή 

Το «Premiere Pro CC» είναι ένα αρκετά απαιτητικό σε πόρους του προσωπικού μας υπολογιστή 

πρόγραμμα. Οι πόροι που χρησιμοποιεί το «Premiere Pro CC» πολλαπλασιάζονται ανάλογα και τις 

προσθήκες που κάνουμε σε μια ακολουθία σε εφέ βίντεο, σε αλλαγές του χρωματισμού της εικόνας, σε 

προσθήκη τίτλων και υπότιτλων κ.α..  

Στην περίπτωση που ο υπολογιστής μας μπορεί να εκτελέσει την αναπαραγωγή προεπισκόπησης της 

ακολουθίας (sequence) χωρίς να υπάρχει καθυστέρηση στο χρόνο επεξεργασίας και σε συνέπεια να μην 

σταματάει η ροή αναπαραγωγής στο παράθυρο προεπισκόπησης (Program: Source). Τότε στην μπάρα 

του χρόνου μέσα στο παράθυρο χρονολογίου (Timeline) θα μας εμφανίζεται μία πράσινη γραμμή σε 

όλη την διάρκεια που υπάρχουν τέτοιου είδους κλιπ για αναπαραγωγή. 

Στην περίπτωση που ο υπολογιστής μας μπορεί να ζορίζεται λίγο για να εκτελέσει την αναπαραγωγή 

προεπισκόπησης της ακολουθίας (sequence) και κατά συνέπεια να υπάρχει μία ελάχιστη καθυστέρηση 

στον χρόνο επεξεργασίας χωρίς να επηρεάζει αισθητά την ροή αναπαραγωγής στο παράθυρο 

προεπισκόπησης (Program: Source). Τότε στην μπάρα του χρόνου μέσα στο παράθυρο χρονολογίου 

(Timeline) θα μας εμφανίζεται μία κίτρινη γραμμή σε όλη την διάρκεια που υπάρχουν τέτοιου είδους 

κλιπ για αναπαραγωγή. 

Στην περίπτωση που ο υπολογιστής μας μπορεί να ζορίζεται αρκετά για να εκτελέσει την αναπαραγωγή 

προεπισκόπησης της ακολουθίας (sequence) και κατά συνέπεια να υπάρχει μία μεγάλη καθυστέρηση 

στον χρόνο επεξεργασίας με συνέπεια να επηρεάζει αισθητά την ροή αναπαραγωγής στο παράθυρο 

προεπισκόπησης (Program: Source). Τότε στην μπάρα του χρόνου μέσα στο παράθυρο χρονολογίου 

(Timeline) θα μας εμφανίζεται μία κόκκινη γραμμή σε όλη την διάρκεια που υπάρχουν τέτοιου είδους 

κλιπ για αναπαραγωγή. 

 

Εικόνα 74 Κόκκινη, κίτρινη και πράσινη γραμμή που υποδηλώνει την δυσκολία επεξεργασίας για την 

προεπισκόπηση αναπαραγωγής 

Στην συνέχεια θα αναλύσουμε τους τρεις τρόπους που έχουμε για να βελτιστοποιήσουμε την ταχύτητα 

αναπαραγωγής για την προεπισκόπηση της ακολουθίας (sequence). 
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7.2 Τρόποι βελτιστοποίησης της αναπαραγωγής προεπισκόπησης στο «Premiere Pro 

CC» 

Ο πρώτος τρόπος είναι να μεταβούμε κάτω δεξιά στο παράθυρο του «Program: Source» και στην 

επιλογή της ανάλυσης να επιλέξουμε μία χαμηλότερη ανάλυση αναπαραγωγής έτσι ώστε να 

χρησιμοποιεί λιγότερη ευκρίνεια της εικόνας κατά την αναπαραγωγή. Οι επιλογές της αναπαραγωγής 

με βάση την ανάλυση είναι: “1/2”, “1/4”, “1/8” και “1/16” (για αναπαραγωγή κλιπ που είναι σε ανάλυση 

τουλάχιστον 4K). Αυτή η δυνατότητα ελαχιστοποιεί τις απαιτήσεις για την επεξεργασία της 

αναπαραγωγής προεπισκόπησης. 

 

Εικόνα 75 Επιλογή της ανάλυσης μέσα το παράθυρο «Program: Source» 

Ο δεύτερος τρόπος είναι να προ-επεξεργαστεί ο υπολογιστής «Render» τα κλιπ που θα επιλέξουμε 

μέσα στην ακολουθία ώστε να μην τα επεξεργάζεται παράλληλα με την αναπαραγωγή προεπισκόπησης. 

Ο τρόπος είναι, πάμε στο παράθυρο του χρονολογίου και μέσα στην ακολουθία πρέπει να επιλέξουμε 

το διάστημα το οποίο επιβαρύνει την επεξεργασία αναπαραγωγής προεπισκόπησης. Τοποθετούμε την 

μπάρα αναπαραγωγής στην αρχή από τα κλιπ και επιλέγουμε το «Mark In», στην συνέχεια πηγαίνουμε 

την μπάρα αναπαραγωγής στο τέλος από τα κλιπ και επιλέγουμε το «Mark Out». Μετά πηγαίνουμε στο 

κεντρικό μενού εργαλείων του «Premiere Pro CC» και επιλέγουμε Sequence > Render In to Out. 

 

Εικόνα 76 Επιλογή για την προ-επεξεργασία των κλιπ μέσα στην ακολουθία 

Στην συνέχεια μας εμφανίζει ένα νέο παράθυρο διαλόγου «Rendering» το οποίο μας δείχνει την πρόοδο 

της προ-επεξεργασίας «Render» των κλιπ μέσα στην ακολουθία. 
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Εικόνα 77 Παράθυρο «Rendering» 

Μόλις ολοκληρωθεί αυτή η διαδικασία το χρώμα της μπάρας του χρόνο μέσα στην ακολουθία θα γίνει 

πράσινο οπότε και η προεπισκόπηση αναπαραγωγής θα γίνεται χωρίς καθυστέρηση. Τα δύο 

μειονεκτήματα αυτής της διαδικασίας είναι: 

1. Για κάθε αλλαγή που θα κάνουμε μετά την προ-επεξεργασία «Render» θα χρειαστεί εκ νέου 

προ-επεξεργασία. 

2. Ο χρόνος για την προ-επεξεργασία «Render» είναι αρκετά μεγάλος. 

Ο τρίτος τρόπος είναι η δημιουργία «Proxies Files» [15] είναι ουσιαστικά καινούργιες εκδόσεις των 

βίντεο που έχουμε προσθέσει στο «Project», χαμηλότερης ανάλυσης και μικρότερου μεγέθους. Έτσι το 

«Premiere Pro CC» αντί να επεξεργαστεί το αρχικό βίντεο, χρησιμοποιεί τις νέες εκδόσεις «Proxies 

Files» των αρχείων έτσι ώστε η αναπαραγωγή της προεπισκόπησης να γίνεται ευκολότερη, λόγω των 

λιγότερων απαιτήσεων υλικού, στον υπολογιστή μας. Επίσης, όταν επιλέξουμε να γίνει η εξαγωγή 

«export» του τελικού μας βίντεο, το «Premiere Pro CC» θα χρησιμοποιήσει τα αρχικά αρχεία βίντεο 

και όχι τα «Proxies Files» έτσι ώστε να έχουμε την μέγιστη δυνατή ποιότητα στο βίντεο που θα 

εξάγουμε. 

Η διαδικασία για να δημιουργήσουμε τα «Proxies Files» είναι: 

1. Πηγαίνουμε στο παράθυρο του «Project» και επιλέγω τα αρχεία βίντεο στα οποία θέλω να 

δημιουργήσω «Proxies Files». 

 

Εικόνα 78 Επιλογή των αρχείων βίντεο μέσα στο παράθυρο του «Project» 

2. Στην συνέχεια, πατάμε δεξί κλικ > Proxy > Create Proxies… 
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Εικόνα 79 Η επιλογή του μενού στα αρχεία βίντεο για την δημιουργία «Proxies Files» 

3. Στην συνέχεια, εμφανίζεται ένα καινούργιο παράθυρο διαλόγου το «Create Proxies». Σε αυτό 

το παράθυρο επιλέγουμε τρεις επιλογές: 

a. «Format»: Σε αυτή την επιλογή θα έχουμε να διαλέξουμε ανάμεσα σε αρχεία “H.264” 

ή σε αρχεία “QuickTime”. Το πλεονέκτημα των αρχείων “H.264” είναι ότι 

δημιουργούνται αρχεία πολύ μικρού μεγέθους και το μειονέκτημα τους είναι ότι τα 

αρχεία που δημιουργούνται είναι αρκετά συμπιεσμένα με αποτέλεσμα το «Premiere 

Pro CC» να θέλει αρκετή επεξεργαστική ισχύ για να τα επεξεργαστεί. Αντίστροφα το 

με το “QuickTime” σαν μειονέκτημα έχουμε ότι τα αρχεία που δημιουργούνται είναι 

μεγαλύτερα σε μέγεθος και ως πλεονέκτημα αυτών των αρχείων είναι ότι δεν υπάρχει 

μεγάλη συμπίεση των αρχείων με αποτέλεσμα το «Premiere Pro CC» να μην χρειάζεται 

μεγάλη επεξεργαστική ισχύ για την επεξεργασία τους. 

b. «Preset»: Σε αυτή την επιλογή διαλέγουμε την ανάλυση και την κωδικοποίηση των 

«Proxies Files». Για την επιλογή “H.264” συνήθως διαλέγουμε το “H.264 Low 

Resolution Proxy” ενώ για την επιλογή “QuickTime” συνήθως διαλέγουμε την 

επιλογή “ProRes Low Resolution Proxy”. 

c. «Destination»: Σε αυτή την επιλογή επιλέγουμε που θέλουν να αποθηκευτούν τα 

«Proxies Files» που θα δημιουργήσουμε. Συνήθως διαλέγουμε την επιλογή να 

αποθηκευτούν δίπλα στα αρχικά αρχεία πολυμέσων σε έναν καινούργιο φάκελο 

«Proxy» (Next to Original Media, in Proxy Folder). Σε διαφορετική περίπτωση 

μπορούμε πατώντας το κουμπί «Browse…» να διαλέξουμε την ακριβή τοποθεσία μέσα 

στον υπολογιστή μας. 
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Εικόνα 80 Οι τρεις επιλογές για την δημιουργία των «Proxies Files» 

4. Στην συνέχεια πατώντας το κουμπί «OK» ανοίγει ένα νέο πρόγραμμα στον υπολογιστή μας, το 

«Media Encoder». Το «Media Encoder» μας το διαθέτει η «Adobe» μαζί με την αγορά του 

προγράμματος του «Premiere Pro CC». Στη συνέχεια μέσω του «Media Encoder» ο 

υπολογιστής μας δημιουργεί τα νέα μας αρχεία «Proxy». 

5. Μόλις δημιουργηθούν τα αρχεία επιστρέφουμε στο περιβάλλον εργασίας του «Premiere Pro 

CC». 

6. Στη συνέχεια, πηγαίνουμε στο παράθυρο του χρονολογίου «Timeline» και μέσα στην 

ακολουθία επιλέγουμε τα κλιπ στα οποία έχουμε δημιουργήσει νέα αρχεία «Proxy». 

7. Στη συνέχεια, πηγαίνουμε στο παράθυρο «Program: Source» και στα εργαλεία κάτω στη μέση 

του παραθύρου επιλέγουμε το «Toggle Proxies» και τότε όσο η επιλογή «Toggle Proxies» είναι 

ενεργοποιημένη  το «Premiere Pro CC» θα χρησιμοποιεί τα «Proxies Files». Σε περίπτωση που 

δεν υπάρχει στην μπάρα των εργαλείων τότε κάτω δεξιά στο παράθυρο επιλέγουμε το εικονίδιο 

“+” για να το προσθέσουμε. 

 

Εικόνα 81 Εικονίδιο «Toggle Proxies» 

Αυτός ο τρόπος είναι πολύ χρήσιμος όταν έχουμε πολλά και μεγάλα αρχεία. Το μειονέκτημα είναι ότι 

θα χρειαστεί αρκετός χρόνος για την δημιουργία των «Proxies Files» μέσω του «Media Encoder». Το 

βασικό πλεονέκτημα είναι ότι διευκολύνει την επεξεργασία της αναπαραγωγής προεπισκόπησης άρα 

μειώνουμε και  τον χρόνο υλοποίησης ενός τελικού βίντεο. Τέλος να ξανά υπενθυμίσουμε ότι στην 

εξαγωγή του τελικού βίντεο. Το «Premiere Pro CC» θα χρησιμοποιήσει τα αρχικά αρχεία και όχι τα 

«Proxies Files».  
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7.3 Επίλογος 

Σε αυτό το κεφάλαιο είδαμε τους τρεις τρόπους βελτιστοποίησης της αναπαραγωγής προεπισκόπησης 

της ακολουθίας μας στο «Premiere Pro CC». Στο επόμενο κεφάλαιο θα δούμε την εισαγωγή τίτλων και 

υπότιτλων στην ακολουθία μας.
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Κεφάλαιο 8ο: Εισαγωγή Τίτλων και Υπότιτλων 

8.1 Εισαγωγή 

Σε αυτό το κεφάλαιο θα δούμε τους δύο τρόπους εισαγωγής τίτλων μέσα στην ακολουθία μας και τις 

επιλογές που μας δίνουν. Στην συνέχεια θα δούμε το νέο παράθυρο «Essential Graphics» που μας 

προσφέρει εισαγωγή έτοιμων προτύπων κινούμενων τίτλων (Motion Graphics). Επίσης θα δούμε τον 

τρόπο εισαγωγής και δημιουργίας υπότιτλων για το τελικό μας βίντεο μαζί με το παράθυρο 

επεξεργασίας τους. Τέλος θα αναλύσουμε τις επιλογές που έχουμε για την εξαγωγή των υπότιτλων. 

8.2 Δημιουργία Τίτλων απλού κειμένου 

Ο πρώτος τρόπος για να προσθέσουμε έναν τίτλο στην ακολουθία μας έχει αναλυθεί στο υποκεφάλαιο 

3.2 και είναι με το Εργαλείο Πληκτρολόγησης «Type Tool». Επιπλέον να αναφέρουμε ότι ο τίτλος 

που δημιουργείτε μπορεί να επεξεργαστεί σαν κλιπ μέσα στο παράθυρο «Effect Controls». 

Ο δεύτερος τρόπος για να προσθέσουμε έναν τίτλο στην ακολουθία μας είναι με την χρήση του 

«Legacy Title» [16].  Πηγαίνοντας στην γραμμή εργαλείων πάνω αριστερά στο «Premiere Pro» 

επιλέγουμε File > New > Legacy Title….  

 

Εικόνα 82 Μενού δημιουργίας «Legacy Title…» 

Στην συνέχεια ανοίγει ένα νέο παράθυρο διαλόγου που ονομάζεται «New Title». Σε αυτό το παράθυρο 

μπορούμε να διαλέξουμε τις διαστάσεις του νέου στοιχείου, τα καρέ ανά δευτερόλεπτο, τον λόγο του 

πλαισίου και το όνομα του τίτλου. 
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Εικόνα 83 Παράθυρο διαλόγου «New Title» του «Legacy Title» 

Μόλις πατήσουμε «OK» δημιουργείται το «Legacy Title» μέσα στο «Project» και μας εμφανίζει ένα 

νέο παράθυρο διαλόγου το οποίο μας δίνει την επιλογή δημιουργίας κειμένου μαζί με πολλές επιλογές 

επεξεργασίας του. 

 

Εικόνα 84 Το νέο αρχείο του «Legacy Title» που δημιουργήθηκε μέσα στο «Project» 

Όταν ολοκληρώσουμε το κείμενο που θέλουμε να δημιουργήσουμε πατάμε «X» στο παράθυρο και οι 

αλλαγές έχουν αποθηκευτεί μέσα στο αρχείο του «Legacy Title». 

 

Εικόνα 85 Παράθυρο δημιουργίας τίτλων με το «Legacy Title» 



Εισαγωγή Τίτλων και Υπότιτλων 

61 

8.3 Εισαγωγή κινούμενων τίτλων μέσω του Essential Graphics 

To «Essential Graphics» είναι ένα παράθυρο του «Premiere Pro CC» που περιέχει μια μεγάλη ποικιλία 

προκατασκευασμένων προτύπων κινούμενων γραφικών (Motion Graphics) [17]. Συνήθως όταν 

θέλουμε να δημιουργήσουμε κινούμενα γραφικά το κατάλληλο πρόγραμμα για την δημιουργία τους 

είναι το «Adobe After Effects». Το «Premiere Pro CC» μας δίνει την δυνατότητα να έχουμε έτοιμα 

πρότυπα (συνήθως υλοποιημένα μέσω του «After Effects») μέσα στο πρόγραμμα επεξεργασίας βίντεο. 

Όταν υλοποιηθεί ένα γραφικό κίνησης μέσα στο πρόγραμμα του «After Effects», μπορεί ο χρήστης να 

το αποθηκεύσει ως αρχείο «.mogrt». Στη συνέχεια το «Premiere Pro CC» έχει την δυνατότητα να το 

εισάγει αυτό το αρχείο και στη συνέχεια έχει τη δυνατότητα επεξεργασίας του κειμένου και άλλων 

ιδιοτήτων διατηρώντας την κίνηση που έχει δημιουργηθεί στο πρόγραμμα του «After Effects». 

Στο παράθυρο του «Essential Graphics» ένα γραφικό στοιχείο μπορεί να ενσωματώσει και να 

επεξεργαστεί πολλές από τις παραμέτρους του «After Effects». Για να ανοίξουμε το παράθυρο του 

«Essential Graphics» μέσα στο «Premiere Pro CC» πηγαίνουμε Window > Essential Graphics. 

Στην περίπτωση που δεν διαθέτουμε το «After Effects» για να δημιουργήσουμε κινούμενα γραφικά 

πρότυπα για το «Premiere Pro CC» ή στην περίπτωση που δεν ξέρουμε να χειριζόμαστε αποτελεσματικά 

το πρόγραμμα του «After Effects» τότε το «Premiere Pro CC» μας έχει την λύση δίνοντας μας δωρεάν 

έτοιμες επιλογές προτύπων. Επίσης μπορούμε να αγοράσουμε έτοιμα πρότυπα μέσω του «Adobe 

Stock» που βρίσκεται στην καρτέλα του «Essential Graphics». Τέλος μπορούμε να αγοράσουμε ή να 

προσθέσουμε δωρεάν προκατασκευασμένα πρότυπα γραφικών από δημιουργούς που τα διαθέτουν στο 

διαδίκτυο. 

 

Εικόνα 86 Παράθυρο του «Essential Graphics» 
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Όταν επιλέξω ένα γραφικό πρότυπο, μπορώ να κρατήσω το αριστερό κλικ πάνω του και να το σύρω 

μέσα στην ακολουθία μου. Επιλέγοντας το γραφικό πρότυπο μέσα στην ακολουθία (sequence) και 

πηγαίνοντας στην καρτέλα του «Essential Graphics» τότε, στην καρτέλα «Edit» μπορώ να επεξεργαστώ 

τις διαθέσιμες παραμέτρους προς αλλαγή. Επίσης μπορώ να το διαχειριστώ και ως κλιπ μέσω της 

καρτέλας του «Effect Controls». 

 

Εικόνα 87 Παράδειγμα παραμέτρων προς επεξεργασία στο παράθυρο του «Essential Graphics» 

8.4 Δημιουργία και Εξαγωγή των Υπότιτλων 

To «Premiere Pro CC» περιλαμβάνει εργαλεία υπότιτλων που μας επιτρέπουν να δημιουργούμε, να 

επεξεργαζόμαστε και να εξάγουμε υπότιτλους μαζί με τα βίντεο μας ή ξεχωριστά σε αρχείο «sidecar» 

[18]. 

Μπορούμε να εισάγουμε και να εμφανίζουμε τους υπότιτλους. Επίσης έχουμε την δυνατότητα να 

επεξεργαζόμαστε το κείμενο, το χρώμα, το φόντο και τον χρόνο που προβάλλονται οι υπότιτλοι μέσα 

στο βίντεο. 

Για να δημιουργήσουμε ένα νέο αρχείο υπότιτλων πηγαίνουμε στο μενού εργαλείων πάνω αριστερά 

στο «Premiere Pro CC» και επιλέγουμε File > New > Captions…. Στην συνέχεια μας ανοίγει ένα νέο 

παράθυρο διαλόγου το «New Captions». 
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Εικόνα 88 Μενού για την δημιουργία υπότιτλων 

 

Εικόνα 89 Παράθυρο διαλόγου για την δημιουργία υπότιτλων 

Στην συνέχεια επιλέγουμε τις ρυθμίσεις του βίντεο για τους υπότιτλους, το «Premiere Pro CC» μας έχει 

έτοιμες τις ρυθμίσεις με βάση τις ρυθμίσεις της ακολουθίας στην οποία προσθέτουμε τους υπότιτλους. 

Πατώντας «OK» δημιουργείται το νέο αρχείο υπότιτλων στο παράθυρο «Project». 

Για να ανοίξουμε το παράθυρο των υπότιτλων «Captions» για να μπορούμε να επεξεργαζόμαστε το 

αρχείο πηγαίνουμε στο μενού εργαλείων πάνω αριστερά στο «Premiere Pro CC» και επιλέγουμε 

Window > Captions.  

Στο πλαίσιο “Type Caption Text Here” προσθέτουμε το κείμενο του υπότιτλου που θέλουμε να 

δημιουργήσουμε. 
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Εικόνα 90 Πλαίσιο πληκτρολόγησης του κειμένου για δημιουργία υπότιτλων 

Στην συνέχεια μπορούμε με τα εργαλεία πάνω στο παράθυρο «Captions» μπορούμε να εφαρμόσουμε 

μορφοποίηση κειμένου, όπως είναι η υπογράμμιση, η πλάγια γραφή, η στοίχιση, το χρώμα κειμένου και 

το χρώμα του φόντου. 

Για να προσθέσουμε περισσότερα μπλοκ από υπότιτλους μέσα στο βίντεο, κάνουμε κλικ στην επιλογή 

Προσθήκη Υπότιτλου «Add Caption» (+) στην κάτω δεξιά γωνία του παραθύρου «Captions». 

Αντίστοιχα για να διαγράψουμε ένα μπλοκ υπότιτλων, επιλέγουμε το Διαγραφή Υπότιτλου «Delete 

Caption» (-). 

Για να προσθέσουμε το αρχείο υπότιτλων μέσα στην ακολουθία μας, σέρνουμε το αρχείο μέσα από το 

παράθυρο του «Project» μέσα στο παράθυρο του χρονολογίου μας στην ακολουθία που θέλουμε να 

προστεθούν οι υπότιτλοι. 

 

Εικόνα 91 Δημιουργία υπότιτλων – Μορφοποίηση κειμένου – Προσθήκη / Αφαίρεση Υπότιτλων 
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Εικόνα 92 Παράδειγμα εμφάνισης των υπότιτλων μέσα στην ακολουθία 

Στην συνέχεια μπορούμε να βλέπουμε τους υπότιτλους στην αναπαραγωγή προεπισκόπησης στο 

παράθυρο του «Program: Source». Σε περίπτωση που δεν μας εμφανίζονται οι υπότιτλοι στην 

αναπαραγωγή προεπισκόπησης πατάμε το εικονίδιο με το κλειδί (ρυθμίσεων) και στην συνέχεια 

επιλέγουμε Closed Captions Display > Enable. 

Για να εξάγουμε τους υπότιτλους επιλέγουμε το αρχείο των υπότιτλων μέσα στο παράθυρο του 

«Project» και επιλέγουμε από το μενού εργαλείων πάνω αριστερά το File > Export > Captions…. Και 

στην συνέχεια μας ανοίγει ένα νέο παράθυρο διαλόγου το «Caption Sidecar Settings For ‘Captions’» 

στο οποίο διαλέγουμε το είδος του αρχείου που θέλουμε να δημιουργήσουμε. Πατώντας «OK» 

επιλέγουμε την τοποθεσία μέσα στον υπολογιστή μας που θέλουμε να αποθηκευτεί και πατάμε 

«Αποθήκευση». 

 

Εικόνα 93 Παράθυρο διαλόγου για την εξαγωγή των υπότιτλων ως ξεχωριστό αρχείο 

Ο άλλος τρόπος για να εξάγουμε τους υπότιτλους είναι να επιλέξουμε την ακολουθία που έχουμε το 

τελικό βίντεο μαζί με τους υπότιτλους και να πάμε στην γραμμή εργαλείων πάνω αριστερά και να 

επιλέξουμε File > Export > Media…. Στην συνέχεια μας ανοίγει το παράθυρο του «Export Settings» 

που είδαμε στο “Κεφάλαιο 3” (βλ. Εικόνα 35). 

Στις ρυθμίσεις του παραθύρου «Export Settings» έχουμε την καρτέλα «Captions». Που μας δίνει τις 

εξής επιλογές στο «Export Options»: 

• None: με την οποία δεν θα γίνει εξαγωγή των υπότιτλων. 
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• Create Sidecar File: με την οποία θα γίνει εξαγωγή ξεχωριστού αρχείου υπότιτλων μαζί με το 

βίντεο. Όταν επιλέξουμε αυτή την επιλογή συνήθως διαλέγουμε το «Format»: “SubRip Subtitle 

Format (.srt)”. 

• Burn Captions into Video: με την οποία θα γίνει εξαγωγή του βίντεο μαζί με την εμφάνιση 

των υπότιτλων σε αυτό. 

 

Εικόνα 94 Καρτέλα «Captions» μέσα στο παράθυρο του «Export Settings» μαζί με τις τρεις επιλογές για την 

εξαγωγή των υπότιτλων 

Στην συνέχεια πατάμε το «Export» για να γίνει η εξαγωγή του βίντεο μαζί με την επιλογή που διαλέξαμε 

για τους υπότιτλους. Αν επιλέξαμε την πρώτη επιλογή «None» τότε δεν θα δημιουργηθούν υπότιτλοι. 

Με την δεύτερη επιλογή «Create Sidecar File» θα δημιουργηθούν σε ξεχωριστό αρχείο μέσα στο 

φάκελο που θα δημιουργηθεί και το τελικό μας βίντεο. Και με την τρίτη επιλογή «Burn Captions into 

Video» οι υπότιτλοι θα είναι ενσωματωμένοι μέσα στο τελικό μας βίντεο. 

8.5 Επίλογος 

Σε αυτό το κεφάλαιο είδαμε τους δύο τρόπους εισαγωγής απλών τίτλων στην ακολουθία μας. Στην 

συνέχεια είδαμε το νέο παράθυρο διαλόγου για το «Legacy Title» που μας προσφέρει περισσότερες 

επιλογές μορφοποίησης του τίτλου που θέλουμε να προσθέσουμε. Επεξηγήσαμε ένα νέο παράθυρο του 

«Premiere Pro CC», το «Essential Graphics», το οποίο μας προσφέρει έτοιμα πρότυπα κινούμενων 

γραφικών για δημιουργία τίτλων. Τέλος αναλύσαμε τον τρόπο εισαγωγής και εξαγωγής υπότιτλων στην 

ακολουθία μας καθώς εξηγήσαμε τις επιλογές στο παράθυρο του «Captions». Στο επόμενο κεφάλαιο 

θα εξηγήσουμε τον ρόλο των καρέ στα κλιπ που εισάγουμε στο πρότζεκτ μας καθώς και στην ακολουθία 

μας. 
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Κεφάλαιο 9ο: Ο ρόλος των Καρέ ανά Δευτερόλεπτο στα Βίντεο – 

FPS (Frame per Second) 

9.1 Εισαγωγή 

Σε αυτό το κεφάλαιο θα εξηγήσουμε την λειτουργία του ρυθμού των καρέ στα βίντεο που έχουμε μέσα 

στο «Premiere Pro CC». Ο ρυθμός καρέ είναι η συχνότητα με την οποία εμφανίζονται ανεξάρτητες 

εικόνες (ακίνητες) στην οθόνη. Αυτό σημαίνει ότι μπορούμε να επιλέξουμε τον αριθμό των 

φωτογραφιών που θα εμφανίζονται ανά δευτερόλεπτο.  

Το ανθρώπινο μάτι μπορεί να δει έως και 10 ή 12 εικόνες ανά δευτερόλεπτο και να τις επεξεργαστεί 

ξεχωριστά, ενώ τα 16 καρέ ανά δευτερόλεπτο είναι ήδη αντιληπτά ως κίνηση. Ωστόσο, σε βίντεο με 

χαμηλότερο ρυθμό καρέ οι κινήσεις εμφανίζονται σπασμωδικές, ενώ οι χαρακτήρες κινούνται με 

αφύσικες ταχύτητες. 

9.2 Τιμές των Καρέ στα βίντεο και η χρήση τους 

Οι φωτογραφικές μηχανές «DSLR» συνήθως μπορούν να μας προσφέρουν πέντε διαφορετικούς 

ρυθμούς καρέ [19]. Αυτοί οι ρυθμοί είναι: 

• 24 καρέ ανά δευτερόλεπτο (24fps): τα περισσότερα βίντεο που καταγράφονται είναι με αυτόν 

τον ρυθμό καρέ. Τα περισσότερα κινηματογραφικά βίντεο είναι τραβηγμένα στα 24fps. Το 

πλάνο βέβαια σε έναν τέτοιο ρυθμό μπορεί να μην φαίνεται τόσο ομαλό στην κίνηση του όπως 

όταν θα καταγραφεί στα 60fps. 

• 25 καρέ ανά δευτερόλεπτο (25fps): το αποτέλεσμα αυτού του ρυθμού των καρέ είναι σχεδόν 

ίδιο με τα 24fps. Ο λόγος που τα χρησιμοποιούμε αυτό τον ρυθμό είναι ότι το 25 προσφέρει 

πολλαπλάσια των 30 και 60 οπότε είναι εύκολα να μετατραπούν τα βίντεο με διαφορετικά καρέ 

ανά δευτερόλεπτο των 30 ή 60 ή 120 καρέ σε 25 καρέ ανά δευτερόλεπτο. 

• 30 καρέ ανά δευτερόλεπτο (30fps): συνήθως οι ζωντανές εκπομπές ή αναμεταδόσεις αγώνων 

εγγράφονται σε 30fps. Ο λόγος είναι ότι με έναν υψηλό ρυθμό καρέ η εικόνα φαίνεται πιο 

ρεαλιστική. Παράδειγμα αν παρακολουθούμε έναν αγώνα μπάσκετ, η κίνηση της μπάλας θα 

φαίνεται αρκετά ομαλή στο μάτι του τηλεθεατή. 

• 60 καρέ ανά δευτερόλεπτο (60fps): η χρήση των 60fps έγινε δημοφιλέστερη όταν 

κατασκευάστηκαν οι φωτογραφικές μηχανές που μπορούν να γράψουν σε ποιότητα «4K» 

(3840x2160 και 4096x2160). Ο λόγος που χρησιμοποιούνται τα 60fps είναι επειδή εφόσον 

μεγάλωσε η ανάλυση των εικόνων που γράφονται, χρειαζόμασταν και μεγαλύτερη λεπτομέρεια 

και ρεαλιστική εμφάνιση στην εικόνα. Αυτό πετυχαίνετε με τον μεγαλύτερο ρυθμό καρέ ανά 

δευτερόλεπτο. 

• 120 καρέ ανά δευτερόλεπτο (120fps): όταν θέλουμε να δημιουργήσουμε βίντεο αργής κίνησης 

(slow motion) θα πρέπει να χρησιμοποιούμε έναν μεγάλο ρυθμό καρέ. Ένας από τους πιο 

συνηθισμένους ρυθμούς για αυτό τον σκοπό είναι τα 120fps.  

Είναι σημαντικό να γνωρίζουμε τις τιμές των καρέ (Frame Rate) που θα χρησιμοποιήσουμε για να 

πετύχουμε τον κατάλληλο ρυθμό καρέ με βάση τις ανάγκες που χρειάζεται να έχει το βίντεο μας. Στην 

ουσία με την ρύθμιση των τιμών των καρέ δημιουργούμε διαφορετική εμπειρία προβολής για τον θεατή. 

Στις περισσότερες περιπτώσεις ο ρυθμός καρέ που επιλέγεται μέσα σε μία ακολουθία είναι τα 25fps 
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επειδή μας προσφέρει πολλαπλάσια των 30,60 και 120 καρέ ανά δευτερόλεπτο και μας επιτρέπει την 

εύκολη μετατροπή τους.  

9.3 Τιμές των Καρέ στην δημιουργία νέας Ακολουθίας (Sequence) 

Οι τιμές των καρέ ανά δευτερόλεπτο που μας ενδιαφέρον σε μία νέα ακολουθία (sequence) είναι δύο. 

Το πρώτο είναι, τα καρέ με τα οποία έχουν εγγραφεί τα βίντεο και θα προσθέσουμε στο «Project» μας 

ώστε να τα επεξεργαστούμε. Και δεύτερον, τα καρέ που ορίζουμε να έχει η ακολουθία (sequence) που 

θα δημιουργήσουμε για να επεξεργαστούμε τα βίντεο.  

Τις τιμές των καρέ στα βίντεο που προσθέτουμε μπορούμε να τα δούμε στο παράθυρο του Project στην 

στήλη δεξιά από το όνομα του κάθε αρχείου βίντεο, στην στήλη «Frame Rate». 

Την τιμή των καρέ ανά δευτερόλεπτο που ορίζουμε να έχει η ακολουθία μας γίνεται είτε στην 

δημιουργία μιας νέας ακολουθίας (sequence) όπως αναλύσαμε στο υποκεφάλαιο 2.5. Όταν έχουμε ήδη 

δημιουργήσει την ακολουθία μας και θέλουμε είτε να δούμε τον ρυθμό καρέ που έχουμε ορίσει είτε να 

αλλάξουμε τον ρυθμό καρέ, έχοντας επιλεγμένη την ακολουθία (sequence), πηγαίνουμε Sequence > 

Sequence Settings… και μας ανοίγει το παράθυρο διαλόγου «Sequence Settings» στον οποίο μπορούμε 

να δούμε ή να αλλάξουμε τον ρυθμό καρέ. 

 

Εικόνα 95 Παράθυρο διαλόγου "Sequence Settings και αλλαγή του ρυθμού καρέ 

Μία ακολουθία (sequence) μέσα στο «Premiere Pro CC» μπορεί να οριστεί έως 60 καρέ ανά 

δευτερόλεπτο. Οποιοδήποτε βίντεο γυρισμένο πάνω από αυτά τα καρέ αυτομάτως θα αναπαράγεται σε 

αργή κίνηση. 

Όταν δημιουργήσουμε μία ακολουθία (sequence) που έχουμε ορίσει τον ρυθμό των καρέ να είναι 25 

καρέ ανά δευτερόλεπτο (25fps) και προσθέσουμε κλιπ μέσα σε αυτή την ακολουθία που έχουν γυριστεί 

σε 25 καρέ ανά δευτερόλεπτο η ταχύτητα αναπαραγωγής αυτών των κλιπ είναι σε κανονική ροή. 

Όταν θα προσθέσουμε κλιπ των 50 καρέ ανά δευτερόλεπτο (50fps) που έχουν γυριστεί σε κανονική ροή 

μέσα στην ίδια ακολουθία, τότε το πρόγραμμα του «Premiere Pro» μετατρέπει αυτά τα 50 καρέ ανά 

δευτερόλεπτο (50fps) σε 25 καρέ ανά δευτερόλεπτο (25fps). Το αποτέλεσμα που θα έχουμε είναι μία 

κανονική ροή αναπαραγωγής με μεγαλύτερη ευκρίνεια και λεπτομέρεια διότι έχουμε περισσότερες 

διαθέσιμες εικόνες να επιλέξει το πρόγραμμα του «Premiere Pro CC» για να αναπαράγει στα 25 καρέ 

ανά δευτερόλεπτο (25fps). 
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Με μία φωτογραφική κάμερα DSLR αν επιλέξουμε ο ρυθμός εγγραφής να είναι στα 100 καρέ ανά 

δευτερόλεπτο (100fps), τότε η ροή εγγραφής γίνεται για χρήση του βίντεο σε αργή κίνηση. Οπότε αν 

προσθέσουμε ένα κλιπ των 100 καρέ ανά δευτερόλεπτο (100fps) μέσα σε μία ακολουθία των 25 καρέ 

ανά δευτερόλεπτο (25fps) τότε το «Premiere Pro CC» θα κάνει την αναπαραγωγή σε αργή κίνηση 

χρησιμοποιώντας τα 100 καρέ ανά δευτερόλεπτο και θα τα χωρίσει σε 25 καρέ ανά δευτερόλεπτο μέσα 

σε 4 δευτερόλεπτα. Αυτό προκύπτει από την διαίρεση του 100 με το 25 που μας κάνει 4. 

9.4 Μετατροπή ενός κλιπ σε Αργή Κίνηση (Slow Motion) 

Όταν θέλουμε ένα κλιπ να το μετατρέψουμε σε αργή κίνηση έχουμε δύο τρόπους: 

1. Αλλαγή του «Speed/Duration» στα κλιπ μέσα στην ακολουθία. Ο τρόπος που μπορούμε να 

αλλάξουμε την ταχύτητα στα κλιπ έχει αναλυθεί στο υποκεφάλαιο 3.4.. 

sΓια παράδειγμα όταν θέλουμε να πετύχουμε μία αργή κίνηση κατά 50% της κανονικής ροής, ορίζουμε 

το «Speed» στο 50%. Τότε αν η ακολουθία μας είναι ρυθμισμένη στα 25 καρέ ανά δευτερόλεπτο (25fps) 

και το κλιπ που θέλουμε να το μετατρέψουμε σε αργή κίνηση είναι γυρισμένο στα 25 καρέ ανά 

δευτερόλεπτο (25fps), τότε το «Premiere Pro CC» θα επεξεργαστεί το κλιπ και θα χωρίσει τα 25 καρέ 

ανά δευτερόλεπτο σε δύο δευτερόλεπτα των περίπου 12 καρέ και θα πολλαπλασιάσει αυτά τα 12 καρέ 

ανά δευτερόλεπτο για να γεμίσουν τα 25 καρέ ανά δευτερόλεπτο που χρειαζόμαστε στην ακολουθία 

μας (sequence). Το αποτέλεσμα αυτής της διαδικασίας είναι να βλέπουμε “κομμένες” εικόνες ή η 

κίνηση να φαίνεται σπασμωδική. 

Αν χρησιμοποιήσουμε στο ίδιο παράδειγμα της ακολουθίας (sequence) των 25 καρέ ανά δευτερόλεπτο 

(25fps) ένα κλιπ των 50 καρέ ανά δευτερόλεπτο (50fps), αντί για το κλιπ των 25 καρέ ανά δευτερόλεπτο 

(25fps) που είχαμε στο προηγούμενο παράδειγμα τότε, μετατρέποντας την ταχύτητα του κλιπ σε 50% 

της κανονικής ροής, το «Premiere Pro CC» χωρίζει τα 50 καρέ ανά δευτερόλεπτο (50fps) σε 25 καρέ 

σε δύο δευτερόλεπτα. Αυτό έχει ως αποτέλεσμα το «Premiere Pro CC» να μην αντιγράψει ίδια καρέ, 

όπως έγινε με το προηγούμενο παράδειγμα, και το αποτέλεσμα είναι μια ομαλή ροή της εικόνας σε αργή 

κίνηση. 

2. Αλλαγή του ρυθμού καρέ στα κλιπ μέσω του «Interpret Footage». Ο λόγος που θέλουμε να 

επιλέξουμε αυτή την μέθοδο είναι όταν για παράδειγμα έχουμε μία ακολουθία των 25 καρέ ανά 

δευτερόλεπτο (25fps) και πολλά κλιπ γυρισμένα σε 50 καρέ ανά δευτερόλεπτο (50fps) τα οποία 

θέλουμε να τα χρησιμοποιήσουμε μέσα στην ακολουθία μας ως κλιπ αργής κίνησης κατά 50%. 

Τότε αντί να επιλέγουμε ένα-ένα τα κλιπ μέσα στην ακολουθία και να μετατρέπουμε την 

ταχύτητα τους μέσω του «Speed/Duration», τότε επιλέγουμε όλα αυτά τα κλιπ μέσα στο 

παράθυρο του «Project» και πατώντας δεξί κλικ > Modify > Interpret Footage… μας οδηγεί 

σε ένα νέο παράθυρο διαλόγου το «Modify Clip» στο οποίο μέσα στην καρτέλα «Frame Rate» 

και το «Assume this frame rate» μπορούμε να μετατρέψουμε το κλιπ των 50 καρέ ανά 

δευτερόλεπτο σε κλιπ των 25 καρέ ανά δευτερόλεπτο για να πετύχουμε την αργή κίνηση στο 

κλιπ χωρίς να μετατρέψουμε τη ταχύτητα του μέσω του «Speed/Duration». Αυτή την 

μέθοδο μπορούμε να την χρησιμοποιήσουμε για όλα τα κλιπ ανεξαρτήτως των καρέ που είναι 

γυρισμένα. 
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Εικόνα 96 Αλλαγή των καρέ ανά δευτερόλεπτο στο παράθυρο του Interpret Footage 

Από τα παραπάνω, παρατηρήσαμε την σημασία του ρυθμού καρέ μέσα σε ένα βίντεο και τι μας 

προσφέρει ανάλογα με το είδος του βίντεο που έχουμε. Επίσης είδαμε ότι μπορούμε να συνδυάσουμε 

κλιπ με διαφορετικούς ρυθμούς καρέ στην ίδια ακολουθία και ο ρυθμός καρέ να μπορεί να 

προσαρμοστεί αυτόματα ώστε να ταιριάζει με την ακολουθία (sequence) διατηρώντας παράλληλα την 

ταχύτητα αναπαραγωγής του. Ακόμη είδαμε  κλιπ που όταν ο ρυθμός καρέ είναι πάνω από 60 καρέ ανά 

δευτερόλεπτο (60fps) ότι το «Premiere Pro CC» τα αντιμετωπίζει ως βίντεο αργής κίνησης. Τέλος 

είδαμε τους δύο τρόπους μετατροπής ενός κλιπ κανονικής ροής σε κλιπ αργής κίνησης (slow motion). 

9.5 Επίλογος 

Σε αυτό το κεφάλαιο είδαμε τον ρυθμό καρέ ανά δευτερόλεπτο στα βίντεο και τον ρόλο τους. Στην 

συνέχεια εξηγήσαμε πως επιλέγουμε τον ρυθμό καρέ στην δημιουργία μιας νέας ακολουθίας ανάλογα 

με τα βίντεο που προσθέσαμε στο «Premiere Pro CC» ώστε να τα επεξεργαστούμε. Τέλος είδαμε τους 

δύο τρόπους μετατροπής ενός κλιπ για την εφαρμογή Αργής Κίνησης (Slow Motion) στα κλιπ μέσα 

στην ακολουθία μας (sequence). 
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Κεφάλαιο 10ο: Συμπεράσματα 

Σε αυτό το κεφάλαιο αναφέρονται τα συμπεράσματα που προέκυψαν από τη διάρθρωση της παρούσας 

πτυχιακής εργασίας. Στην οποία προσπαθήσαμε να δώσουμε στον αναγνώστη και στον τηλεθεατή των 

βίντεο που δημιουργήθηκαν παράλληλα με την εργασία, την βασική γνώση για να μπορέσουν να 

χρησιμοποιήσουν το πρόγραμμα του «Premiere Pro CC» για την γραμμική επεξεργασία βίντεο. 

Ο χώρος της γραμμικής επεξεργασίας βίντεο είναι πλέον βασικός πυλώνας του οπτικοακουστικού 

περιεχομένου. Στις μέρες μας, είναι πλέον στην καθημερινότητα μας να αλληλοεπιδράμε μέσω των 

οπτικοακουστικών μέσων που χρησιμοποιούνται σε π.χ. κοινωνικά δίκτυα, τηλεόραση, διαδίκτυο, 

κινηματογράφο κ.α..  

Ο χώρος της διαφήμισης συνέβαλε να αναπτυχθεί με ραγδαίο ρυθμό τα οπτικοακουστικά μέσα. Τα 

χρήματα που δαπανήθηκαν δημιούργησαν νέες τεχνολογίες για την γραμμική επεξεργασία βίντεο. 

Παράλληλα με τη εξέλιξη της τεχνολογίας τα τελευταία χρόνια ο χώρος των οπτικοακουστικών μέσων 

ενισχύθηκε νέα μέσα που βελτίωσαν αισθητά την επεξεργασία και το τελικό αποτέλεσμα των προϊόντων 

βίντεο. 

Με την γνώση της πτυχιακής αυτής εργασίας ένας αναγνώστης μπορεί να μάθει να χειρίζεται το 

πρόγραμμα του «Premiere Pro CC» σε προχωρημένο επίπεδο με αποτέλεσμα την δημιουργία και την 

γραμμική επεξεργασία ενός τελικού προϊόντος βίντεο. Η συγκεκριμένη γνώση θεωρείται απαραίτητη 

και επαρκή για να μπορέσει να απασχοληθεί δημιουργικά και επαγγελματικά στον χώρο των 

οπτικοακουστικών μέσων. 

Τέλος, με την συγκεκριμένη πτυχιακή εργασία έγινε η καταγραφή των βασικών γνώσεων πάνω στο 

πρόγραμμα του «Premiere Pro CC» έτσι ώστε ο χρήστης να έχει την ικανότητα να χρησιμοποιήσει έως 

και σε επαγγελματικό βαθμό τις γνώσεις αυτές. Υπάρχουν αρκετές ακόμη δυνατότητες που μας 

προσφέρει το «Premiere Pro CC» οι οποίες μπορούν να μελετηθούν μελλοντικά και να εξελίξουν την 

υπάρχουσα πτυχιακή εργασία έτσι ώστε οι νέες γνώσεις που θα αντληθούν να βελτιώσουν ακόμη 

περισσότερο τις τεχνικές επεξεργασίας γραμμικού βίντεο. 
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